The smart way to learn Microsoft Word 2013
—one step at a time!

Experience learning made easy—and quickly teach yourself how to create great-looking documents with Microsoft Word 2013. With Step by Step, you set the pace—building and practicing the skills you need, just when you need them!

- Create documents on your PC or touch-enabled device
- Master core tools for designing and editing docs
- Manage page layout, style, and navigation
- Organize content in tables, lists, and charts
- Add pictures, diagrams, and other visuals
- Create custom styles and templates

Your Step by Step digital content includes:
- All the book's practice files—ready to download at: http://aka.ms/Word2013sbs/files
- Fully searchable ebook. See the instruction page at the back of the book.

Follow the easy numbered steps
1. Use screenshots to check your work
2. Get helpful tips and pointers
3. Build your skills hands-on with ready-made practice files

Microsoft Word 2013
Build exactly the skills you need. Learn at the pace you want.

Joan Lambert and Joyce Cox

Practice files plus ebook
Microsoft® Word 2013

Step by Step

Joan Lambert
Joyce Cox
Contents

Introduction ........................................................................................................................................ xi
  Who this book is for ................................................................................................................... xi
  How this book is organized .......................................................................................................... xi
  Download the practice files ...................................................................................................... xii
  Your companion ebook ............................................................................................................. xiv
  Get support and give feedback .................................................................................................. xv
  Errata ........................................................................................................................................... xv
  We want to hear from you ........................................................................................................... xv
  Stay in touch ............................................................................................................................... xv

PART 1

Basic Word documents

1 Explore Microsoft Word 2013  .................................................................................................. 3
  Identifying new features of Word 2013 ....................................................................................... 6
  If you are upgrading from Word 2010 ...................................................................................... 6
  If you are upgrading from Word 2007 ....................................................................................... 7
  If you are upgrading from Word 2003 ....................................................................................... 8
  Working in the Word 2013 user interface .............................................................................. 9
    Identifying program window elements ................................................................................ 10
    Sidebar: About buttons and arrows ..................................................................................... 13
    Working with the ribbon ...................................................................................................... 14
    Sidebar: Adapting exercise steps ......................................................................................... 18
  Opening, navigating, and closing documents ......................................................................... 31
  Viewing documents in different ways ...................................................................................... 37
  Getting help with Word 2013 .................................................................................................. 46
  Key points ................................................................................................................................... 49
## 2 Enter, edit, and proofread text  51

Starting, entering text in, and saving documents ........................................ 52
  *Sidebar*: Saving files to SkyDrive .................................................. 54
  *Sidebar*: Document compatibility with earlier versions of Word ................. 58
Modifying text ...................................................................................... 58
  *Sidebar*: Inserting one document into another ...................................... 59
  *Sidebar*: About the Clipboard ............................................................. 67
Finding and replacing text ................................................................. 68
Fine-tuning text ................................................................................. 75
  *Sidebar*: Installing Office tools .......................................................... 84
  *Sidebar*: Viewing document statistics .................................................. 84
  *Sidebar*: Modifying spelling and grammar checking settings ....................... 85
Correcting spelling and grammatical errors ............................................ 86
Key points .......................................................................................... 91

## 3 Modify the structure and appearance of text  93

Applying styles to text ........................................................................ 94
Changing a document’s theme ............................................................ 102
Manually changing the look of characters ............................................ 108
  *Sidebar*: Character formatting and case considerations ............................ 118
Manually changing the look of paragraphs ........................................... 118
  *Sidebar*: Finding and replacing formatting ............................................ 130
Creating and modifying lists .............................................................. 130
  *Sidebar*: Formatting text as you type ................................................... 136
Key points .......................................................................................... 137
## 4 Organize information in columns and tables 139

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presenting information in columns</td>
<td>140</td>
</tr>
<tr>
<td>Creating tabbed lists</td>
<td>147</td>
</tr>
<tr>
<td>Presenting information in tables</td>
<td>149</td>
</tr>
<tr>
<td><strong>Sidebar</strong>: Performing calculations in tables.</td>
<td>155</td>
</tr>
<tr>
<td><strong>Sidebar</strong>: Other table layout options</td>
<td>160</td>
</tr>
<tr>
<td>Formatting tables</td>
<td>161</td>
</tr>
<tr>
<td><strong>Sidebar</strong>: Quick Tables</td>
<td>162</td>
</tr>
<tr>
<td>Key points</td>
<td>167</td>
</tr>
</tbody>
</table>

## 5 Add simple graphic elements 169

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inserting and modifying pictures</td>
<td>170</td>
</tr>
<tr>
<td><strong>Sidebar</strong>: About online pictures and video clips.</td>
<td>177</td>
</tr>
<tr>
<td>Inserting screen clippings</td>
<td>178</td>
</tr>
<tr>
<td>Drawing and modifying shapes</td>
<td>180</td>
</tr>
<tr>
<td>Adding WordArt text</td>
<td>185</td>
</tr>
<tr>
<td><strong>Sidebar</strong>: Formatting the first letter of a paragraph as a drop cap.</td>
<td>190</td>
</tr>
<tr>
<td><strong>Sidebar</strong>: Inserting symbols</td>
<td>191</td>
</tr>
<tr>
<td>Key points</td>
<td>191</td>
</tr>
</tbody>
</table>

## 6 Preview, print, and distribute documents 193

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previewing and adjusting page layout</td>
<td>194</td>
</tr>
<tr>
<td>Controlling what appears on each page</td>
<td>200</td>
</tr>
<tr>
<td>Preparing documents for electronic distribution</td>
<td>206</td>
</tr>
<tr>
<td><strong>Sidebar</strong>: Digitally signing documents</td>
<td>211</td>
</tr>
<tr>
<td>Printing and sending documents</td>
<td>212</td>
</tr>
<tr>
<td>Key points</td>
<td>219</td>
</tr>
</tbody>
</table>
PART 2

Document enhancements

7 Insert and modify diagrams  223
Creating diagrams ................................................................. 224
Modifying diagrams ............................................................ 231
Creating picture diagrams ................................................... 239
Key points ............................................................ 243

8 Insert and modify charts  245
Inserting charts ................................................................. 246
Modifying charts ............................................................... 250
Using existing data in charts ................................................. 259
Key points ............................................................... 263

9 Add visual elements  265
Changing a document’s background ....................................... 266
Adding watermarks ............................................................. 272
Inserting preformatted document parts ................................. 276
  Sidebar: Drawing text boxes ............................................... 286
Building equations ............................................................. 288
  Sidebar: Setting mathematical AutoCorrect options .............. 294
Key points ................................................................. 295

10 Organize and arrange content  297
Reorganizing document outlines .......................................... 298
Arranging objects on the page ............................................. 304
Using tables to control page layout ....................................... 315
Key points ................................................................. 319
11 Create documents for use outside of Word 321

- Saving Word documents in other formats ........................................ 322
- *Sidebar: Editing a PDF file in Word* ............................................. 324
- Designing accessible documents .................................................. 329
- Creating and modifying web documents ....................................... 333
- Creating and publishing blog posts .............................................. 342
- Key points .................................................................................... 343

<table>
<thead>
<tr>
<th>PART 3</th>
<th>Additional techniques</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Link to information and content 347</td>
</tr>
<tr>
<td>13</td>
<td>Reference content and content sources 373</td>
</tr>
</tbody>
</table>

**PART 3**

**Additional techniques**

12 Link to information and content 347

- Linking to external resources .................................................. 348
- Embedding linked objects ....................................................... 353
- Inserting and linking to bookmarks ........................................ 360
- Displaying document information in fields ............................. 365
- Key points ................................................................................ 371

13 Reference content and content sources 373

- Inserting and modifying footnotes and endnotes ................. 374
- Creating and modifying tables of contents ......................... 378
  - *Sidebar: Tables of authorities* ............................................. 385
  - *Sidebar: Tables of figures* ................................................. 386
- Creating and modifying indexes ............................................ 388
- Adding sources and compiling bibliographies ................... 394
- Key points ............................................................................ 401
14 Work with mail merge 403
Preparing data sources .......................................................... 404
  Sidebar: Using an Outlook contacts list as a data source .......... 411
Preparing main documents ...................................................... 411
Merging main documents and data sources ......................... 415
  Sidebar: Printing envelopes .................................................. 418
Sending personalized email messages to multiple recipients .... 419
Creating and printing labels .................................................... 423
Key points ........................................................................ 427

15 Collaborate on documents 429
Adding and reviewing comments ......................................... 430
Tracking and managing document changes ......................... 434
Comparing and merging documents ..................................... 438
  Sidebar: Managing document versions ................................. 442
Password-protecting documents ............................................ 442
Controlling changes .............................................................. 446
Coauthoring documents ......................................................... 450
  Sidebar: Restricting who can do what to documents ............... 451
Key points ........................................................................ 451

16 Work in Word more efficiently 453
Creating custom styles and templates ................................. 454
  Creating and attaching templates ...................................... 454
  Creating and modifying styles ......................................... 460
Creating custom building blocks ........................................ 472
Changing default program options ...................................... 478
Customizing the Quick Access Toolbar ............................... 487
  Sidebar: Using add-ins ....................................................... 492
Customizing the ribbon ........................................................ 494
  Sidebar: Customizing the status bar .................................. 500
Key points ........................................................................ 501
Glossary ......................................................... 503

Keyboard shortcuts .................................................. 511
  Word 2013 keyboard shortcuts .................................. 511
    Perform common tasks ........................................... 511
    Work with documents and webpages ......................... 512
    Edit and move text and graphics ........................... 514
    Apply character and paragraph formatting ................. 519
    Work with mail merge and fields ......................... 521
    Use the Language bar ........................................... 522
    Perform function key tasks .................................. 522
  Office 2013 keyboard shortcuts ................................. 525
    Display and use windows ....................................... 525
    Use dialog boxes ................................................ 525
    Use the Backstage view ......................................... 527
    Navigate the ribbon ............................................ 527
    Change the keyboard focus without using the mouse ...... 527
    Undo and redo actions ......................................... 528
    Change or resize the font .................................... 528
    Move around in text or cells ................................ 528
    Move around in and work in tables ......................... 529
    Access and use panes and galleries ....................... 529
    Access and use available actions .......................... 530
    Find and replace content .................................... 530
    Use the Help window .......................................... 530
  Creating custom keyboard shortcuts .......................... 531

Index ........................................................................... 533

About the authors ..................................................... 557

How to download your ebook ...................................... 559

Survey page ............................................................. 560
Introduction

Part of the Microsoft Office 2013 suite of programs, Microsoft Word 2013 is a sophisticated word-processing program that helps you quickly and efficiently author, format, and publish all the business and personal documents you are ever likely to need. *Microsoft Word 2013 Step by Step* offers a comprehensive look at the features of Word that most people will use most frequently.

Who this book is for

*Microsoft Word 2013 Step by Step* and other books in the *Step by Step* series are designed for beginning to intermediate-level computer users. Examples shown in the book generally pertain to small and medium-sized businesses but teach skills that can be used in organizations of any size. Whether you are already comfortable working in Word and want to learn about new features in Word 2013 or are new to Word, this book provides invaluable hands-on experience so that you can create and modify professional documents with ease.

How this book is organized

This book is divided into three parts. Part 1 teaches readers how to create, print, and distribute standard documents in Word 2013. Tutorials lead the reader through the process of creating document elements such as formatted text, columns, lists, tables, and simple graphics. Part 2 discusses ways of enhancing standard document content with diagrams, charts, and other visual elements; organizing and arranging content; and saving Word files in various formats. Part 3 delves into advanced techniques and tools that include creating reference elements, creating mail merge documents, collaborating on document creation, and customizing program functionality to fit the way you work. This three-part structure allows readers who are new to the program to acquire basic skills and then build on them, while readers who are comfortable with Word 2013 basics can focus on material that is of the most interest to them.

Chapter 1 contains introductory information that will primarily be of interest to readers who are new to Word or are upgrading from Word 2003 or an earlier version. If you have worked with a more recent version of Word, you might want to skip directly to Chapter 2.
This book has been designed to lead you step by step through all the tasks you’re most likely to want to perform with Word 2013. If you start at the beginning and work your way through all the exercises, you will gain enough proficiency to be able to create and work with most types of Word documents. However, each topic is self-contained, so you can jump in anywhere to acquire exactly the skills you need.

Download the practice files

Before you can complete the exercises in this book, you need to download the book’s practice files to your computer. These practice files can be downloaded from the following page:

http://aka.ms/Word2013sbs/files

**IMPORTANT** The Word 2013 program is not available from this website. You should purchase and install that program before using this book.

If you would like to be able to refer to the completed versions of practice files at a later time, you can save the practice files that you modify while working through the exercises in this book. If you save your changes and later want to repeat the exercise, you can download the original practice files again.

The following table lists the practice files for this book.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>File</th>
</tr>
</thead>
</table>
| Chapter 1: Explore Microsoft Word 2013 | Prices.docx  
Procedure.docx  
Rules.docx |
| Chapter 2: Enter, edit, and proofread text | Brochure.docx  
Letter.docx  
Orientation.docx  
Regulations.docx |
| Chapter 3: Modify the structure and appearance of text | Association.docx  
BambooInformation.docx  
BambooStyled.docx  
Cottage.docx  
Guidelines.docx |
<table>
<thead>
<tr>
<th>Chapter</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4: Organize information in columns and tables</td>
<td>ConsultationA.docx&lt;br&gt;ConsultationB.docx&lt;br&gt;RepairCosts.docx&lt;br&gt;RoomPlanner.docx</td>
</tr>
<tr>
<td>Chapter 5: Add simple graphic elements</td>
<td>AgendaDraft.docx&lt;br&gt;Announcement.docx&lt;br&gt;Authors.docx&lt;br&gt;Joan.jpg&lt;br&gt;Joyce.jpg&lt;br&gt;OTSI-Logo.png</td>
</tr>
<tr>
<td>Chapter 6: Preview, print, and distribute documents</td>
<td>InfoSheetA.docx&lt;br&gt;InfoSheetB.docx&lt;br&gt;InfoSheetC.docx&lt;br&gt;OfficeInfo.docx</td>
</tr>
<tr>
<td>Chapter 7: Insert and modify diagrams</td>
<td>Garden.jpg&lt;br&gt;Neighborhood.docx&lt;br&gt;Park.jpg&lt;br&gt;Pond.jpg&lt;br&gt;ServiceA.docx&lt;br&gt;ServiceB.docx&lt;br&gt;Woods.jpg</td>
</tr>
<tr>
<td>Chapter 8: Insert and modify charts</td>
<td>CottageA.docx&lt;br&gt;CottageB.docx&lt;br&gt;CottageC.docx&lt;br&gt;Temperature.xlsx</td>
</tr>
<tr>
<td>Chapter 9: Add visual elements</td>
<td>AuthorsDraft.docx&lt;br&gt;Flyer.docx&lt;br&gt;MarbleFloor.jpg&lt;br&gt;OTSI-Logo.png&lt;br&gt;Welcome.docx</td>
</tr>
<tr>
<td>Chapter 10: Organize and arrange content</td>
<td>BambooInfo.docx&lt;br&gt;DeliveryTruckPurchase.docx&lt;br&gt;Loan.xlsx&lt;br&gt;LoanComparisons.docx&lt;br&gt;OfficeProcedures.docx</td>
</tr>
<tr>
<td>Chapter</td>
<td>File</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Chapter 11: Create documents for use outside of Word</td>
<td>ParkingRules.docx</td>
</tr>
<tr>
<td></td>
<td>WebPlanner.docx</td>
</tr>
<tr>
<td>Chapter 12: Link to information and content</td>
<td>Conductors.docx</td>
</tr>
<tr>
<td></td>
<td>Conductors.pptx</td>
</tr>
<tr>
<td></td>
<td>ProceduresFields.docx</td>
</tr>
<tr>
<td></td>
<td>RulesBookmarks.docx</td>
</tr>
<tr>
<td></td>
<td>Symphony.docx</td>
</tr>
<tr>
<td></td>
<td>VisitorGuide.docx</td>
</tr>
<tr>
<td>Chapter 13: Reference content and content sources</td>
<td>BambooBibliography.docx</td>
</tr>
<tr>
<td></td>
<td>BambooInfoA.docx</td>
</tr>
<tr>
<td></td>
<td>BambooInfoB.docx</td>
</tr>
<tr>
<td></td>
<td>ProceduresContents.docx</td>
</tr>
<tr>
<td></td>
<td>RulesIndex.docx</td>
</tr>
<tr>
<td>Chapter 14: Work with mail merge</td>
<td>AnniversaryLetter.docx</td>
</tr>
<tr>
<td></td>
<td>CustomerList.xlsx</td>
</tr>
<tr>
<td></td>
<td>ThankYouEmail.docx</td>
</tr>
<tr>
<td>Chapter 15: Collaborate on documents</td>
<td>CompetitiveAnalysisA.docx</td>
</tr>
<tr>
<td></td>
<td>CompetitiveAnalysisB.docx</td>
</tr>
<tr>
<td></td>
<td>Loans.docx</td>
</tr>
<tr>
<td></td>
<td>ProceduresRestricted.docx</td>
</tr>
<tr>
<td></td>
<td>Service.docx</td>
</tr>
<tr>
<td></td>
<td>ServiceCP.docx</td>
</tr>
<tr>
<td></td>
<td>ServiceTA.docx</td>
</tr>
<tr>
<td>Chapter 16: Work in Word more efficiently</td>
<td>Agenda.docx</td>
</tr>
<tr>
<td></td>
<td>AuthorsBlank.docx</td>
</tr>
<tr>
<td></td>
<td>Bamboo.docx</td>
</tr>
<tr>
<td></td>
<td>RoomFlyer.docx</td>
</tr>
</tbody>
</table>

Your companion ebook

With the ebook edition of this book, you can do the following:

- Search the full text
- Print
- Copy and paste

To download your ebook, please see the instruction page at the back of the book.
Get support and give feedback

The following sections provide information about getting help with this book and contacting us to provide feedback or report errors.

Errata

We’ve made every effort to ensure the accuracy of this book and its companion content. Any errors that have been reported since this book was published are listed on our Microsoft Press site, which you can find at:

http://aka.ms/Word2013sbs/errata

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, email Microsoft Press Book Support at mspinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the addresses above.

We want to hear from you

At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance for your input!

Stay in touch

Let’s keep the conversation going! We’re on Twitter at: http://twitter.com/MicrosoftPress.
Chapter at a glance

**Style**
Apply styles to text, page 94

- **Navigation**
  - Search document

- **HEADING**
  - Moving to a New Home
  - Keeping Bags at Bay
  - Mothy Bugs

- **Mites**
  - Bamboo mites, not to be confused with spider mites, are throughout the leaf of the plant. With magnification, they themselves on the underside of the leaves, which is not

- **Keeping Bags at Bay**
  - Mothy Bugs

- **The main problem with mites is their infestation with mite cereal which is not**

**Format**
Manually change the look of characters, page 108

- **Employee Orientation**
  - Guideline
  - Project Goals
  - Familiarize employees with the concept of service.
  - Make service a natural part of their lives.
  - Engage and motivate them.
  - Foster a sense of teamwork among all employees across departments.

**Color**
Change a document’s theme, page 102

- **ALL ABOUT BAMBOO**
  - Information Sheet
  - Bamboo is a versatile and important part of the economy. Here at Wm. Wm. Importers, we import a variety of bamboo.

**List**
Create and modify lists, page 130

1. Each Apartment shall be used for residential purposes only, except such professional and administrative businesses as may be permitted by ordinance; provided there is no external evidence thereof.

2. No mowing or offensive activity shall be carried on, by, or upon any apartment, unless it is undertook.

3. No sports, activities, or games, whether organized or unorganized, that might cause annoyance or nuisance, shall be played in any Limited Common Area or Common Area.

4. No Owner shall keep any animal within his or her apartment for any purpose other than as a pet. The number of cats and/or dogs any Owner may keep is limited to the following:
   - 2 small dogs
   - 1 large dog
   - 2 small cats
   - 1 large cat

5. No large dogs are allowed, either as pets of Owners or as pets of visitors.

6. The Board reserves the right to make exceptions to this rule.

7. All pets must reside within their Owner's Apartments.

8. Pets must be on a leash when in the Common Area.
Modify the structure and appearance of text

IN THIS CHAPTER, YOU WILL LEARN HOW TO

▪ Apply styles to text.
▪ Change a document’s theme.
▪ Manually change the look of characters.
▪ Manually change the look of paragraphs.
▪ Create and modify lists.

The appearance of your documents helps to convey their message. Microsoft Word 2013 can help you develop professional-looking documents whose appearance is appropriate to their contents. You can easily format words and paragraphs so that key points stand out and the structure of your document is clear. You can also change the look of major elements within a document by applying predefined sets of formatting called styles, and you can change the look of selected text by applying predefined combinations called text effects. In addition, you can change the fonts, colors, and effects throughout a document with one click by applying a theme.

In this chapter, you’ll first experiment with built-in styles and text effects, and then you’ll change the theme applied to a document. You’ll change the look of individual words, and then you’ll change the indentation, alignment, and spacing of individual paragraphs. You’ll also add borders and shading to make paragraphs stand out. Finally, you’ll create and format both bulleted and numbered lists.

PRACTICE FILES To complete the exercises in this chapter, you need the practice files contained in the Chapter03 practice file folder. For more information, see “Download the practice files” in this book’s Introduction.
Applying styles to text

You don’t have to know much about character and paragraph formatting to be able to format your documents in ways that will make them easier to read and more professional looking. With a couple of mouse clicks, you can easily change the look of words, phrases, and paragraphs by using styles. More importantly, you can structure a document by applying styles that are linked to outline levels. In doing so, you build a document outline that is reflected in the Navigation pane and can be used to create a table of contents.

SEE ALSO For information about tables of contents, see “Creating and modifying tables of contents” in Chapter 13, “Reference content and content sources.”

Styles can include character formatting (such as font, size, and color), paragraph formatting (such as line spacing and outline level), or a combination of both. Styles are stored in the template that is attached to a document. By default, blank new documents are based on the Normal template. The Normal template includes a standard selection of styles that fit the basic needs of most documents. These styles include nine heading levels, various text styles including those for multiple levels of bulleted and numbered lists, index and table of contents entry styles, and many specialized styles such as those for hyperlinks, quotations, placeholders, captions, and other elements.

By default, Word makes the most common predefined styles available in the Styles gallery on the Home tab.

The Styles gallery in a new, blank document based on the Normal template.
Applying styles to text

Styles can be used for multiple purposes: to affect the appearance of the content, to build a document outline, and to tag content as a certain type so that you can easily locate it.

**Heading styles define a document’s outline.**

Styles stored in a template are usually based on the Normal style and use only the default body and heading fonts associated with the document’s theme, so they all go together well. For this reason, formatting document content by using styles produces a harmonious effect. After you apply styles from the current style set, you can easily change the look of the entire document by switching to a different style set, which associates different formatting rules with the same styles. So if you have applied the Heading 1 style to a paragraph, you can change its formatting simply by changing the style set.

**SEE ALSO** For information about document theme elements, see “Changing a document’s theme,” later in this chapter.

Style sets are available from the Document Formatting menu on the Design tab.

**Facilities**

**Office**
The Consolidated Messenger front office and lobby is located at the front of the building as the main entrance for our office employees and our customers.

The front office space consists of a counter with three stations, each with photo copier and computer terminals with high-speed connections. The lobby provides a package preparation area and bins of retail items (envelopes, tape, marking pens, etc.) for customers, as well as a bank of mailboxes. The waste receptacles in the package preparation area should be emptied every night or more often as needed to ensure a neat appearance. The retail bins should be checked and restocked throughout the day as needed. Office employees are responsible for both of these activities.

The office hours are from 8:00 A.M. to 9:00 P.M., Monday through Saturday. Current mailboxes have access to them 24 hours a day.

**Warehouse**
The rear of the building contains the warehouse, which occupies the major portion of the building space. The warehouse is divided into four separate areas: Receiving and Inventory, Packaging, and Inventory storage:

- The Receiving area consists of two loading docks (also used for working) and an 12 x 12 ft. area with racks for holding incoming packages. The racks are made of metal and can be moved by the shipping company.
- The Shipping area just opposite the Receiving area, and also has an 12 x 12 ft. area with racks for holding packages which are shipped. The racks are made of wood and are divided by the shipping company.
- The Packaging area has two tables, each with a 3 ft. board, and a box for packaging materials, such as bubble wrap, tape, and Styrofoam peanuts, and labeling materials.
- The Inventory area has three racks for overflow supplies.

**Phone System**
The phone system in the office has an intercom and a direct connection to each of the main offices.
Pointing to a style set in the gallery displays a live preview of the effects of applying that style set to the entire document.

**TIP** Style sets provide a quick and easy way to change the look of an existing document. You can also modify style definitions by changing the template on which the document is based. For more information about styles and templates, see “Creating custom styles and templates” in Chapter 16, “Work in Word more efficiently.”

In this exercise, you’ll experiment with the styles in the Normal template and change the look of a document by switching to a different style set.

**SET UP** You need the BambooInformation document located in the Chapter03 practice file folder to complete this exercise. Open the document in Print Layout view, and then follow the steps.

1. Scroll through the document to gain an overview of its contents. Notice that the document begins with a centered title and subtitle, and there are several headings throughout.

2. Display the Navigation pane. Notice that the Headings page of the Navigation pane does not reflect the headings in the document.

3. On the Home tab, click the Styles dialog box launcher to display the Styles pane. If it floats above the page, drag it by its title bar to the right edge of the program window to dock it.
4 If necessary, change the zoom level of the page to fit the page content between the
Navigation pane and the Styles pane.

![Image of Microsoft Word interface]

You're ready to build a document structure by applying styles.

**TIP** Squiggly lines indicating possible grammatical errors might appear below some
words in this document. You can remove them by right-clicking each word and then
clicking Ignore.

5 Click anywhere in the document title, *All About Bamboo*, and then click in the first
heading, *Moving to a New Home*. In the Styles pane, notice that each of these
paragraphs is styled as Normal. Because the document headings do not have
heading styles applied to them, they do not appear in the Navigation pane.

6 Click again in the document title and then, in the Styles pane, click **Title** to apply the
style. Notice that Word applies the style to the entire paragraph even if you haven’t
selected it.

7 In the Styles pane, point to the **Title** style.
Chapter 3  Modify the structure and appearance of text

8 Click anywhere in the Information Sheet paragraph and then, in the Styles pane, click Subtitle to apply the style. Notice that the Navigation pane still contains no headings. This is because the Title and Subtitle styles are not associated with outline levels.

9 Select the bold heading Moving to a New Home. In the Styles pane, point to the Heading 1 style to display a description of the style. Notice that the paragraph description includes Outline Level: Level 1 to indicate that paragraphs with this style appear at the first level of an outline.

10 In the Styles gallery, point to the Heading 1 style to display a live preview of the selected text with that style. Notice the different result of pointing to the style in the Styles gallery and in the Styles pane.

11 In the Styles gallery or in the Styles pane, click Heading 1 to apply the style. Notice that the selected heading also appears in the Navigation pane.

Document headings provide not only an outline structure and formatting; you can also use them to collapse entire sections. This is a nifty new feature in Word 2013. Let’s try it.
In the document, point to the heading to display a downward-angled gray triangle to its left. Then click the gray triangle to hide the content that follows the heading.

The gray triangle changes to a right-facing white triangle to indicate that content is hidden.

Click in the text above the heading. Notice that the white triangle remains visible to the left of the heading to indicate that content associated with the heading is hidden.

Click the white triangle to the left of the heading to display the hidden document content.

Select Staying Healthy, and click the Heading 1 style to apply it. Then select Keeping Bugs at Bay and on the Quick Access Toolbar, click the Repeat button to apply the same style to the selected text. This is a technique you can use to quickly apply multiple instances of a style.

**KEYBOARD SHORTCUT** Press Ctrl+Y to repeat the previous action. For more information about keyboard shortcuts, see “Keyboard shortcuts” at the end of this book.

Display the page so that both underlined headings are visible. Select Mites, press and hold the Ctrl key, and then select Mealy Bugs. With both headings selected, click Heading 2 in the Styles gallery or Styles pane to simultaneously apply the style to both selections.
Chapter 3  Modify the structure and appearance of text

Applying multiple heading styles creates a multilevel outline in the Navigation pane.

Notice that Heading 3 now appears in the Styles pane. The Normal template contains many more headings than are currently displayed in the Styles pane or Styles gallery. At the bottom of the Styles pane, click Options to open the Style Pane Options dialog box. Notice that Show next heading when previous level is used is selected by default; this is the setting that caused Heading 3 to appear in the Styles pane after you applied the Heading 2 style.

Let’s look at the many styles that are available for use in this document.

In the Style Pane Options dialog box, click the Select styles to show arrow. Notice that you can display all styles, all styles that are in the document template, all styles that are currently being used, or a selection of “recommended” styles.

SEE ALSO  For more information about working with styles and the Styles pane, see “Creating custom styles and templates” in Chapter 16, “Work in Word more efficiently.”
You can choose to display any of four categories of styles in the Styles pane.

19 In the Select styles to show list, click All styles. In the Select how list is sorted list, click Alphabetical. Then in the Style Pane Options dialog box, click OK to display the full list of available styles in the Styles pane.

**TIP** To add any style from the Styles pane to the Styles gallery, point to the style name, click the arrow that appears, and then click Add To Style Gallery.

20 Scroll through the Styles pane to view the wide range of available styles, and point to any that interests you to display a description. Notice that many of the built-in styles are intended for specific uses, such as the Index and TOC (table of contents) styles.

21 In the Navigation pane, just above the headings, click the Jump to the beginning button to return to the document title.

Now we’ll apply some character styles to the document content, so we can see how they change when we change the style set.

22 In the first paragraph of the document, select the company name Wide World Importers. In the Styles group, click the More button to expand the Styles gallery, and then click the Intense Reference thumbnail to apply the style.

23 In the second paragraph, near the end of the first sentence, select the word clumping and apply the Emphasis style. Then, at the end of the sentence, apply the same style to the word running. Notice that the application of these character styles does not affect the Navigation pane contents.
24 Close the **Navigation** pane and the **Styles** pane. On the **View** tab, in the **Zoom** group, click **Multiple Pages** to display both pages of the document in the window.

25 On the **Design** tab, in the **Document Formatting** gallery, point to each of the style sets in the **Built-In** area to display a live preview of the effect of applying that style set. Notice how the style set affects the appearance of the headings and text to which you applied styles, and also how it affects the document length.

26 In the **Document Formatting** gallery, click the **Basic (Elegant)** thumbnail. Then on the **View** tab, click **Page Width** to have a closer look at the changes. Notice that the selected style set formats the font of the **Title** style as uppercase, and the font of the **Intense Reference** style as “small caps” and underlined.

---

**ALL ABOUT BAMBOO**

Information Sheet

Bamboo is a versatile and important part of the economy and culture in many countries. Here at **World of Bamboo**, we import a variety of home décor products made from bamboo. But if you want to add a tropical flair to your garden as well as in your home, try planting one or several of the many varieties of bamboo used for landscaping.

There are two different categories to consider, depending on the look you want to achieve and the amount of maintenance you’re prepared to do: clumping and running. The running varieties spread out underground runners which can show up far from the parent plant. They can be easily contained using either trench or barrier methods described below. Runners are ideal for hedges or screens. Clumping bamboos have very short root systems, expanding no more than a few inches per year. They are less cold-hardy than runners, but make excellent specimen plants.

You can control the case of text by applying a style.

---

**CLEAN UP** Close the **Bamboo Information** document, saving your changes if you want to.

---

**Changing a document’s theme**

Every document you create is based on a template, and the look of the template is controlled by a theme. The theme is a combination of coordinated colors, fonts, and effects that visually convey a certain tone. To change the look of a document, you can apply a different theme by clicking the Themes button in the Document Formatting group on the **Design** tab, and then making a selection in the Themes gallery.
Changing a document’s theme

The default installation of Word 2013 offers 21 themes to choose from.

If you like the background elements of one theme but not the colors or fonts, you can mix and match theme elements. First apply the theme that most closely resembles the look you want, and then select colors and fonts from the Theme Colors and Theme Fonts galleries in the Document Formatting group.

In addition to colors and fonts, you can control more subtle elements such as paragraph spacing and visual effects that are associated with a theme.

If you create a combination of theme elements that you would like to be able to use with other documents, you can save the combination as a new theme. By saving the theme in the default Document Themes folder, you make the theme available in the Themes gallery. However, you don’t have to store custom themes in the Document Themes folder; you can store them anywhere on your hard disk, on removable media, or in a network location. To use a theme that is stored in a different location, click Browse For Themes at the bottom of the Themes menu, locate the theme you want in the Choose Theme Or Themed Document dialog box, and then click Open to apply that theme to the current document.
The default Document Themes folder is stored within your user profile. On a default freestanding installation, the folder is located at C:\Users\<user name>\AppData\Roaming\Microsoft\Templates\Document Themes. In a corporate environment with managed computer configurations, the user profile folder might be located elsewhere. To find the location of your Document Themes folder, click Save Current Theme at the bottom of the Themes menu and then in the Save Current Theme dialog box, click the icon at the left end of the address bar to display the full path to the Document Themes folder.

By default, Word applies the Office theme to all new, blank documents. In Word 2013, the Office theme uses a primarily blue palette, the Calibri font for body text, and Calibri Light for headings. You can make a different theme the default by applying the theme you want and then clicking Set As Default in the Document Formatting group.

If multiple people create corporate documents for your company, you can ensure that everyone’s documents have a common look and feel by assembling a custom theme and making it available to everyone. Use theme elements that reflect your corporate colors, fonts, and visual style, and then save the theme to a central location or send the theme file by email and instruct your colleagues to save it to the default Document Themes folder.

In this exercise, you’ll apply a theme to an existing document and change the colors and fonts. Then you’ll save the new combination as a custom theme.

**SET UP** You need the BambooStyled document located in the Chapter03 practice file folder to complete this exercise. Open the document, and then follow the steps.

1. On the Design tab, in the Document Formatting group, click the Themes button to display the Themes menu.
2. Point to each thumbnail in turn to display a live preview of the theme. (Scroll through the gallery so that you can explore all the themes.)
3. In the Themes gallery, click Facet to change the colors and fonts to those defined for that theme. Notice that the font and character formatting controlled by the styles and style set you applied to the document in the previous exercise do not change; the title and first-level headings remain uppercase.

**TIP** If you have manually applied formatting to document content, the theme does not override the manual formatting. To ensure that all document elements are controlled by the theme, click Reset To The Default Style Set on the Document Formatting menu.
4 In the **Document Formatting** group, click the **Colors** button to display the **Colors** menu.

5 Point to any color palette that interests you to preview its effects on the document. Notice that the first color in each palette is applied to the **Title** and **Intense Reference** styles, and different shades of the third color are applied to the **Subtitle**, **Heading 1**, and **Heading 2** styles. Each color in the palette has a specific role assigned to it.

6 In the **Theme Colors** gallery, click the **Orange** palette. The selected colors replace the **Facet** colors, but nothing else in the document changes.

7 In the **Document Formatting** group, click the **Fonts** button to display the **Theme Fonts** menu.
You can modify the theme by applying any font set.

8 Point to any font set that interests you to preview its effects on the document. Each font set includes two fonts—the first is used for headings and the second for body text. In some font sets, the heading and body fonts are the same.

9 In the Theme Fonts gallery, click Georgia. The selected fonts replace the Facet fonts, but the colors and style elements remain the same.

Now that you’ve made some changes to the theme, let’s save the modified theme so you can reuse it on other documents.

10 In the Document Formatting group, click the Themes button, and then at the bottom of the menu, click Save Current Theme to display the contents of the Document Themes folder in the Save Current Theme dialog box.

11 In the File name box, replace the suggested name with My Theme, and then click Save.
12. Display the Themes menu. Notice that it now includes a Custom area that contains your theme.

You can apply your custom theme to any document.

13. Click away from the menu to close it without making a selection.

**CLEAN UP** Close the BambooStyled document, saving your changes if you want to.

**TIP** If you want to delete the custom theme you created in this topic, open File Explorer, navigate to the Document Themes folder, and delete the My Theme file, or, in Word, display the Themes menu, right-click your custom theme, and click Delete. Note that the second method removes the theme choice from the gallery but does not remove the theme file from your Themes folder.
Manually changing the look of characters

Word 2013 makes changing the look of content in a styled document almost effortless. But styles and themes can’t do everything. To be able to precisely control the look of your text, you need to know how to manually change individual elements.

When you enter text in a document, it is displayed in a specific font. By default, the font used for text in a new blank document is 11-point Calibri, but you can change the font of any element at any time. The available fonts vary from one computer to another, depending on the programs installed. Common fonts include Arial, Verdana, and Times New Roman.

You can vary the look of a font by changing the following attributes:

- **Size**  Almost every font comes in a range of sizes, which are measured in points from the top of letters that have parts that stick up (ascenders), such as h, to the bottom of letters that have parts that drop down (descenders), such as p. A point is approximately 1/72 of an inch (about 0.04 centimeters).

- **Style**  Almost every font has a range of font styles. The most common are regular (or plain), italic, bold, and bold italic.

- **Effects**  Fonts can be enhanced by applying effects, such as underlining, small capital letters (small caps), or shadows.

- **Color**  A palette of coordinated colors is available, and you can also specify custom colors.

- **Character spacing**  You can alter the spacing between characters by pushing them apart or squeezing them together.

Although some attributes might cancel each other out, they are usually cumulative. For example, you might use a bold font style in various sizes and various shades of green to make words stand out in a newsletter. Collectively, the font and its attributes are called *character formatting*.

You apply character formatting from one of three locations:

- **Mini Toolbar**  Several common formatting buttons are available on the Mini Toolbar that appears when you select text.

  ![Mini Toolbar](image)

  The Mini Toolbar appears temporarily when you select text, becomes transparent when you move the pointer away from the selected text, and then disappears entirely.
### Font group on the Home tab
This group includes buttons for changing the font and most of the font attributes you are likely to use.

The Font group.

### Font dialog box
Less-commonly applied attributes such as small caps and special underlining are available from the Font dialog box, which you display by clicking the Font dialog box launcher.

Most font attributes are set from the Font page of the dialog box, except character spacing and OpenType attributes, which are set on the Advanced page.

In addition to applying character formatting to change the look of characters, you can apply predefined text effects to a selection to add more zing. Clicking the Text Effects And Typography button in the Font group on the Home tab displays a gallery of effects matched to the current theme colors.
You can apply any predefined effect in the gallery to selected text, or you can click options below the gallery and define a custom effect.

These effects are dramatic, so you’ll probably want to restrict their use to document titles and similar elements to which you want to draw particular attention.

In this exercise, you’ll format the text in a document by changing its font, style, size, color, and character spacing. You’ll experiment with highlighting and apply text effects. Then you’ll return selected text to its original condition by clearing some formatting you no longer want.

**SET UP** You need the Guidelines document located in the Chapter03 practice file folder to complete this exercise. Open the document, and then follow the steps.

1. In the second bullet point, click anywhere in the word *natural*.
2. On the **Home** tab, in the **Font** group, click the **Underline** button to underline the word containing the cursor. Notice that you did not have to select the entire word.

   **KEYBOARD SHORTCUT** Press Ctrl+U to underline the active word or selection.

3. In the fourth bullet point, click anywhere in the word *all*, and then on the **Quick Access Toolbar**, click the **Repeat** button. Word repeats the previous formatting command. Again, although you did not select the entire word, it is now underlined.

   **KEYBOARD SHORTCUT** Press Ctrl+Y to repeat the previous command.
4 In the same bullet point, click anywhere in the word *across*. In the Font group, click the Underline arrow and then click **Thick underline** (the third option) to apply a thick underline to the word. Then click the next word, *departments*, and click the Underline button (not the arrow). Notice that the thick underline has now been assigned to the Underline button.

**TIP** You can choose an underline style and color from the Underline gallery or from the Font dialog box.

5 Select the **Employee Orientation** heading, and leave the pointer in place to display the Mini Toolbar.

6 On the Mini Toolbar, click the **Bold** button to apply bold formatting to the heading. Notice that the active buttons on the Mini Toolbar and in the Font group on the **Home** tab indicate the attributes applied to the selection.

**KEYBOARD SHORTCUT** Press Ctrl+B to make the active word or selection bold.

7 On the Mini Toolbar, click the **Format Painter** button.

**TIP** The Format Painter button is available in the Clipboard group on the Home tab.
8. Move the pointer into the selection area to the left of the Guidelines subtitle, and click the mouse button to apply the formatting of Employee Orientation to Guidelines.

9. With Guidelines selected, on the Home tab, in the Font group, click the Font arrow to expand the Font gallery.

10. Scroll through the gallery of available fonts, press the letter I to move to the fonts beginning with that letter, and then click Impact to apply that font to the Guidelines heading.

   **TROUBLESHOOTING** If Impact is not available, select any heavy font that catches your attention.

11. In the Font group, click the Font Size arrow, and then in the list, click 20. The size of the heading text decreases to 20 points.
Manually changing the look of characters

**TIP** You can increase or decrease the font size in set increments by clicking the Increase Font Size or Decrease Font Size buttons in the Font group or on the Mini Toolbar, or by pressing Ctrl+> or Ctrl+<.

Next we'll apply some font formatting that isn't available from the ribbon.

12 With **Guidelines** still selected, click the **Font** dialog box launcher to open the **Font** dialog box.

**KEYBOARD SHORTCUT** Press Ctrl+Shift+F to display the Font dialog box.

13 On the **Font** page, in the **Effects** area, select the **Small caps** check box.

14 Click the **Advanced** tab to display character spacing and typographic features.

![Font dialog box]

*The Spacing option is currently set to Expanded.*

**TIP** OpenType is a common scalable computer font format that incorporates options to enhance the font’s ability to support advanced typographic capabilities and render multiple languages gracefully.
To the right of the Spacing list, in the By box, select 0.25 pt and enter 10 pt (the pt stands for points). Then click OK. In the document, press the Home key to release the selection. Notice that the manually formatted text appears in small capital letters with the spacing between the characters expanded by 10 points.

You can expand and contract the spacing between letters to create different effects.

Select Employee Orientation. In the Font group, click the Font Color arrow, and then in the Theme Colors palette, click the top green swatch (Green, Accent 6) to change the color of the selected words.

**TIP** To apply the Font Color button’s current color, you can simply click the button (not its arrow). If you want to apply a color that is not shown in the Theme Colors or Standard Colors palette, click More Colors. In the Colors dialog box, click the color you want in the honeycomb on the Standard page, or click the color gradient or enter values for a color on the Custom page.

Select Community Service Committee. In the Font group, click the Text Effects and Typography button and then, in the gallery, point to each of the thumbnails to preview its effect on the selected heading.

Below the gallery, click Outline, and then in the Theme Colors palette, click the Green, Accent 6 square to outline the letters in the same color you applied to Employee Orientation.

This is interesting, but let’s get a little fancier.

Click the Text Effects and Typography button, click Shadow, and then click Shadow Options to display the Text Effects page of the Format Text Effects pane.
The Format Text Effects pane includes the Text Fill & Outline page and the Text Effects page.

20 In the Shadow settings, click the Presets button, and then in the Outer section of the Presets gallery, click the thumbnail at the right end of the top row.

21 Click the Color button, and then in the Theme Colors palette, click the bottom green swatch (Green, Accent 6, Darker 50%) to create a dark green shadow.

22 At the top of the Format Text Effects pane, click the Text Fill & Outline button to display that page. Then click the Text Fill heading to expand those settings.

You can format characters with a solid or gradient fill.
23 With Solid fill selected, click the Color button, and then in the Theme Colors palette, click the top green swatch (Green, Accent 6).

24 Click the Text Outline heading to expand those settings. With Solid line selected, click the Color button, and then in the Theme Colors palette, click the second green swatch from the bottom (Green, Accent 6, Darker 25%). You have now applied three text effects to the selected text using three shades of the same green. Notice that there are many other options for formatting the text outline.

You can format characters with a solid or gradient outline of varying widths.

25 Close the Format Text Effects pane and click away from the selected heading to review the effects of your changes.

26 In the first bullet point, select the phrase the concept of service. On the Mini Toolbar, click the Text Highlight Color arrow, and click the Bright Green swatch in
the top row. The selected phrase is now highlighted in green, and the Text Highlight Color button shows bright green as its active color.

**TIP** If you click the Text Highlight Color button without first making a selection, the shape of the mouse pointer changes to a highlighter that you can drag across text. Click the button again, or press Esc, to turn off the highlighter.

27 In the fifth bullet point, double-click the word **brainstorming**. Hold down the Ctrl key, double-click **planning**, and then double-click **leadership**.

28 In the Font group, click the Change Case button, and then click **UPPERCASE**.

**KEYBOARD SHORTCUT** Press Shift+F3 to change the case of the selected text. Press Shift+F3 multiple times to move through the case options (Sentence case, UPPERCASE, lowercase, and Capitalize Each Word). Note that the options vary based on the selected text. If the selection ends in a period, Word does not include the Capitalize Each Word option in the rotation. If the selection does not end in a period, Word does not include Sentence case in the rotation.

29 In the document, click away from the bullet point to release the selection and review the results. The selected words now appear in all capital letters.

---

**Community Service Committee**

**Employee Orientation**

**GUIDELINES**

**Project Goals**
- Familiarize employees with the concept of service.
- Make service a natural part of their lives.
- Engage and motivate them.
- Forge a sense of teamwork among all employees across departments.
- Provide appropriate skills development through BRAINSTORMING, PLANNING, and LEADERSHIP opportunities.
- Meet genuine community needs.

Instead of retyping, you can have Word change the case of words.

**TIP** To remove all styles and formatting other than highlighting from selected text, click the Clear Formatting button in the Font group. To remove only manually applied formatting (and not styles) press Ctrl+Spacebar. To remove highlighting, select the highlighted text and then in the Text Highlight Color menu, click No Color.

**CLEAN UP** Close the Guidelines document, saving your changes if you want to.
Character formatting and case considerations

The way you use case and character formatting in a document can influence its visual impact on your readers. Used judiciously, case and character formatting can make a plain document look attractive and professional, but excessive use can make it look amateurish and detract from the message. For example, using too many fonts in the same document is the mark of inexperience, so don’t use more than two or three.

Bear in mind that lowercase letters tend to recede, so using all uppercase (capital) letters can be useful for titles and headings or for certain kinds of emphasis. However, large blocks of uppercase letters are tiring to the eye.

**TIP** Where do the terms *uppercase* and *lowercase* come from? Until the advent of computers, individual characters made of lead were assembled to form the words that would appear on a printed page. The characters were stored alphabetically in cases, with the capital letters in the upper case and the small letters in the lower case.

Manually changing the look of paragraphs

A paragraph is created by entering text and then pressing the Enter key. A paragraph can contain one word, one sentence, or multiple sentences. You can change the look of a paragraph by changing its indentation, alignment, and line spacing, as well as the space before and after it. You can also put borders around it and shade its background. Collectively, the settings you use to vary the look of a paragraph are called *paragraph formatting*.

In Word, you don’t define the width of paragraphs and the length of pages by defining the area occupied by the text; instead you define the size of the white space—the left, right, top, and bottom margins—around the text. You click the Margins button in the Page Setup group on the Page Layout tab to define these margins, either for the whole document or for sections of the document.

**SEE ALSO** For information about setting margins, see “Previewing and adjusting page layout” in Chapter 6, “Preview, print, and distribute documents.” For information about sections, see “Controlling what appears on each page” in the same chapter.

Although the left and right margins are set for a whole document or section, you can vary the position of the paragraphs between the margins. The quickest way to indent a paragraph from the left is to click the Increase Indent button; clicking the Decrease Indent button has the opposite effect.
**TIP** You cannot increase or decrease the indent beyond the margins by using the Increase Indent and Decrease Indent buttons. If you do need to extend an indent beyond the margins, you can do so by setting negative indentation measurements in the Paragraph dialog box.

Another way to control the indentation of lines is by dragging markers on the horizontal ruler to indicate where each line of text starts and ends. You can set four individual indent markers for each paragraph:

- **First Line Indent** The paragraph's first line of text begins at this marker.
- **Hanging Indent** The paragraph's second and subsequent lines of text begin at this marker at the left end of the ruler.
- **Left Indent** The left side of the paragraph aligns with this marker.
- **Right Indent** The paragraph text wraps when it reaches this marker at the right end of the ruler.

You display the horizontal and vertical rulers by selecting the Ruler check box in the Show group on the View tab.

![Horizontal Ruler with Indent Markers](image)

You can manually change a paragraph’s indentation by moving the indent markers on the horizontal ruler.

Setting a right indent indicates where the lines in a paragraph should end, but sometimes you might want to specify where only one line should end. For example, you might want to break a title after a specific word to make it look balanced on the page. You can end an individual line by inserting a text wrapping break (more commonly known as a line break). After positioning the cursor where you want the break to occur, click the Breaks button in the Page Setup group on the Page Layout tab, and then click Text Wrapping. Word indicates the line break with a bent arrow (visible when hidden formatting symbols are shown). Inserting a line break does not start a new paragraph, so when you apply paragraph formatting to a line of text that ends with a line break, the formatting is applied to the entire paragraph, not only to that line.

**KEYBOARD SHORTCUT** Press Shift+Enter to insert a line break.
You can also determine the positioning of a paragraph between the left and right margins by changing its alignment. There are four paragraph alignment options:

- **Align Left**  
  Aligns each line of the paragraph at the left margin, with a ragged right edge  
  **KEYBOARD SHORTCUT** Press Ctrl+L to left-align a paragraph.

- **Center**  
  Aligns the center of each line in the paragraph between the left and right margins, with ragged left and right edges  
  **KEYBOARD SHORTCUT** Press Ctrl+E to center-align a paragraph.

- **Align Right**  
  Aligns each line of the paragraph at the right margin, with a ragged left edge  
  **KEYBOARD SHORTCUT** Press Ctrl+R to right-align a paragraph.

- **Justify**  
  Aligns each line between the margins and modifies the spacing within the line to create even left and right edges  
  **KEYBOARD SHORTCUT** Press Ctrl+J to justify a paragraph.

**TIP** If you know that you want to create a centered paragraph, you don’t have to type the text and then align the paragraph. You can use the Click And Type feature to create appropriately aligned text. Move the pointer to the center of a blank area of the page, and when the pointer’s shape changes to an I-beam with centered text attached, double-click to insert the cursor in a centered paragraph. Similarly, you can double-click at the left edge of the page to enter left-aligned text and at the right edge to enter right-aligned text.

You can align lines of text in different locations across the page by using tab stops. The easiest way to set tab stops is to use the horizontal ruler. By default, Word sets left-aligned tab stops every half inch (1.27 centimeters). To set a custom tab stop, start by clicking the Tab button located at the left end of the ruler until the type of tab stop you want appears.

*The tab options.*
You have the following options:

- **Left Tab** Aligns the left end of the text with the tab stop
- **Center Tab** Aligns the center of the text with the tab stop
- **Right Tab** Aligns the right end of the text with the tab stop
- **Decimal Tab** Aligns the decimal point in the text (usually a numeric value) with the tab stop
- **Bar Tab** Draws a vertical line at the position of the tab stop

After selecting the type of tab stop you want to set, simply click the ruler where you want the tab stop to be. Word then removes any default tab stops to the left of the one you set.

The ruler displays the custom tab stops for the selected paragraph.

To change the position of an existing custom tab stop, drag it to the left or right on the ruler. To delete a custom tab stop, drag it away from the ruler. Or, if you find it too difficult to "grab" the tab stops on the ruler, you can set, clear, align, and format tab stops from the Tab dialog box, which you open by clicking the Tabs button at the bottom of the Paragraph dialog box. You might also work from this dialog box if you want to use tab leaders—visible marks such as dots or dashes connecting the text before the tab with the text after it. For example, tab leaders are useful in a table of contents to carry the eye from the text to the page number.

To align the text to the right of the cursor with the next tab stop, press the Tab key. The text is then aligned on the tab stop according to its type. For example, if you set a center tab stop, pressing Tab moves the text so that its center is aligned with the tab stop.
You can specify the alignment and tab leader for each tab.

To make it obvious where one paragraph ends and another begins, you can add space between them. There are several methods for adjusting paragraph spacing within a document:

- To set the spacing for all paragraphs in a document, choose from the Paragraph Spacing options in the Document Formatting group on the Design tab.

Each paragraph spacing option controls space around and within the paragraph.
To set the spacing for only selected paragraphs, adjust the **Spacing Before** and **Spacing After** settings in the **Paragraph** group on the **Page Layout** tab.

To make a quick adjustment to selected paragraphs, click the paragraph spacing commands on the **Line And Paragraph Spacing** menu that is available in the **Paragraph** group on the **Home** tab.

You can set internal line spacing or add or remove external space from this menu.

When you want to make several adjustments to the alignment, indentation, and spacing of selected paragraphs, it is sometimes quicker to use the Paragraph dialog box than to click buttons and drag markers. Clicking the Paragraph dialog box launcher on either the **Home** tab or the **Page Layout** tab opens the Paragraph dialog box.

![Paragraph dialog box](image)

*The Indents And Spacing page of the Paragraph dialog box.*

Manually changing the look of paragraphs
You can do a lot with the options in the Paragraph dialog box, but to make a paragraph really stand out, you might want to put a border around it or shade its background. (For real drama, you can do both.) Clicking the Border arrow in the Paragraph group on the Home tab displays a menu of border options. You can select a predefined border from the Borders menu, or click Borders And Shading at the bottom of the menu to display the Borders And Shading dialog box, in which you can select the style, color, width, and location of the border.

You can customize many aspects of the border. By clicking Options you can set the specific distance between the paragraph text and border.

In this exercise, you'll change text alignment and indentation, insert and modify tab stops, modify paragraph and line spacing, and add borders and shading to paragraphs.

**SET UP** You need the Cottage document located in the Chapter03 practice file folder to complete this exercise. Open the document, click the Show/Hide ¶ button to turn on the display of formatting marks, and then follow the steps.

1. On the View tab, in the Show group, select the Ruler check box. Then adjust the zoom level to display most or all of the paragraphs in the document.
In the following steps, we give measurements in inches. If you're using a different measurement unit, you can substitute approximate measurements in those units. If you want to change the measurement units Word uses, display the Advanced page of the Word Options dialog box. Then in the Display area, click the units you want in the Show Measurements In Units Of list, and click OK.

First we'll modify the paragraph formatting.

2 Select the first two paragraphs (Welcome! and the next paragraph). Then on the Home tab, in the Paragraph group, click the Center button to center the lines between the margins.

TIP When applying paragraph formatting, you don't have to select the entire paragraph.

3 In the second paragraph, click to the left of your. Then on the Page Layout tab, in the Page Setup group, click the Breaks button, and click Text Wrapping. Notice that Word inserts a line break character and moves the part of the paragraph that follows that character to the next line.

The bent arrow after cottage indicates that you have inserted a line break.

SEE ALSO For information about page and section breaks, see “Controlling what appears on each page” in Chapter 6, “Preview, print, and distribute documents.”

4 Click anywhere in the third paragraph, and then on the Home tab, in the Paragraph group, click the Justify button. Word inserts space between the words in the lines of the paragraph so that the edges of the paragraph are flush against both the left and right margins.

5 With the cursor still in the third paragraph, on the horizontal ruler, drag the Left Indent marker (the rectangle at the left margin) to the 0.5 inch mark. The First Line Indent and Hanging Indent markers (the triangles) move with the Left Indent marker.
At the right end of the ruler, drag the Right Indent marker (the triangle at the right margin) to the 6 inch mark. The paragraph is now indented a half inch in from each of the side margins.

![Image of a ruler with indents]

**Welcome!**

We would like to welcome you to our cottage, your home away from home during your visit to beautiful Walla Walla.

Please take a few minutes to read the following information about our home and its amenities. Knowing where things are and how they work will help make your stay more comfortable and relaxing.

**Kitchen**

Our kitchen is fully equipped for everything from a simple breakfast to a gourmet dinner. You’ll find a coffee maker on the counter and a grinder in the cupboard above.

Left and right indents are often used to make paragraphs such as quotations stand out.

Click in the **Be careful** paragraph, and then in the **Paragraph** group, click the **Increase Indent** button.

Now we’ll override the default tab stops.

Select the **Pillows, Blankets, Towels, and Dish towels** paragraphs. Ensure that the **Left Tab** marker is active at the top of the vertical ruler (if it’s not, click the tab stop marker until the **Left Tab** stop appears), click the ruler at the 2 inch mark to insert a custom left-aligned tab at that location on the ruler and void the default tab stops prior to that location.

In the **Pillows** paragraph, click to the left of **There**, press **Backspace** to delete the space, and then press the **Tab** key to align the description with the tab stop. Repeat the process to insert tabs in each of the next three paragraphs. The part of each paragraph that follows the colon is now aligned at the 2-inch mark, producing more space than you need.

Select the four paragraphs containing tabs, and on the ruler, drag the custom **Left Tab** stop from the 2 inch mark to the 1.25 inch mark.

**TROUBLESHOOTING** If your attempts to drag the tab stop result in placing an additional tab stop on the ruler, drag the extra tab stop away from the ruler to delete it.

With the four paragraphs still selected, on the ruler, drag the **Hanging Indent** marker to the tab stop at the 1.25 inch mark (the **Left Indent** marker moves with it) to cause the second line of the paragraphs to start in the same location as the first line. Then press **Home** to release the selection so you can review the results.
You can use hanging indents to create table-like effects.

12 At the bottom of the document, select the three paragraphs containing dollar amounts. At the top of the vertical ruler, click the Tab button three times to display the Decimal Tab button, and then click the ruler at the 3 inch mark.

13 In each of the three paragraphs, replace the space to the left of the dollar sign with a tab to align the prices on the decimal points.

Next, we’ll adjust the line spacing.

14 Select the Pillows paragraph, hold down the Ctrl key, and then select the Blankets, Towels, Limousine winery tour, and In-home massage paragraphs.

15 On the Home tab, in the Paragraph group, click the Line and Paragraph Spacing button, and then click Remove Space After Paragraph. Then press the Home key to review the results. Now only the last paragraphs of the two lists have extra space after them.

Removing space from between list paragraphs makes them easier to read.

And finally, we’ll apply paragraph borders.

16 Move to the top of the document, and click anywhere in the Please take a few minutes paragraph. On the Home tab, in the Paragraph group, click the Border arrow, and then click Outside Borders.

Manually changing the look of paragraphs
Click anywhere in the Be careful paragraph, click the Border arrow, and then at the bottom of the list, click Borders and Shading to display the Borders page of the Borders and Shading dialog box.

In the Setting area, click the 3-D icon to select that border style. Scroll through the Style list and click the fourth style from the bottom (the wide gradient border). Then click the Color arrow, and in the top row of the Theme Colors palette, click the Red, Accent 2 swatch.

**TIP** If you want only one, two, or three sides of the selected paragraphs to have a border, click the buttons surrounding the image in the Preview area to remove the border from the other sides.

In the Borders and Shading dialog box, click the Shading tab.

You can use the options on this page to format the background of the selected paragraph.

Click the Fill arrow, and then in the Theme Colors palette, click the lightest-colored square in the red column (Red, Accent 2, Lighter 80%). Then click OK to close the Borders and Shading dialog box. A border surrounds the paragraph, and a light red color fills its background. The border stretches all the way to the right margin.
To achieve a more balanced look, on the Page Layout tab (not the Home tab), in the Paragraph group, enter .5” in the Right box and press Enter. Then on the Home tab, in the Paragraph group, click the Center button. The paragraph is now centered between the page margins and within its surrounding box.

In the Paragraph group, click the Show/Hide ¶ button to hide the formatting marks to better display the results of your work.

---

Welcome!

We would like to welcome you to our cottage, your home away from home during your visit to beautiful Walla Walla.

Please take a few minutes to read the following information about our home and its amenities. Knowing where things are and how they work will help make your stay more comfortable and relaxing.

Kitchen

Our kitchen is fully equipped for everything from a simple breakfast to a gourmet dinner. You’ll find a coffee maker on the counter and a grinder in the cupboard above.

Be careful when using the hot water—very hot!

Spill something on the glass cooktop? Please use the special cleaner under the sink to remove the spill before your next use.

Dining room

Our cozy dining room table expands into a round table that will seat eight. Just use the stools from the kitchen for those larger gatherings.

Den

The downstairs sitting area is a relaxing place to watch TV or a movie or listen to music after a day out. You’ll find board games in the cupboard.

Linens

If you require additional linens during your stay, you will find them in the following locations:

- Pillows: There are extras on the shelf in the closet.
- Blankets: You will find additional blankets in the boxes under each bed. This is also where you will find additional sheets.
- Towels: These are in the linen closet beside the downstairs bathroom.
- Dish towels: There is a pile in the bottom drawer to the right of the kitchen sink.

Services

The following services are available to enhance your visit:

- Limousine winery tour: $49.99 per person
- In-home massage: $55.00 per hour
- Half-day guided fishing trip: $325.00 for up to three people

---

A combination of a border and shading really makes text stand out. Don’t overdo it!

**CLEAN UP** Close the Cottage document, saving your changes if you want to.
Finding and replacing formatting

In addition to searching for words and phrases in the Find And Replace dialog box, you can use the dialog box to search for a specific character format, paragraph format, or style, and replace it with a different one.

SEE ALSO For information about finding and replacing text, see “Finding and replacing text” in Chapter 2, “Enter, edit, and proofread text.”

To search for a specific format and replace it with a different format:

1. On the Home tab, in the Editing group, click the Replace button to display the Replace tab of the Find and Replace dialog box, and then click More to expand the dialog box.

   KEYBOARD SHORTCUT Press Ctrl+H to display the Replace tab of the Find And Replace dialog box.

2. With the cursor in the Find what box, in the Replace section, click Format, and on the Format menu, click either Font to open the Find Font dialog box, Paragraph to open the Find Paragraph dialog box, or Style to open the Find Style dialog box.

3. In the dialog box, click the format or style you want to find, and then click OK.

4. Click in the Replace With text box, click Format, click Font, Paragraph, or Style, click the format or style you want to substitute for the original format or style, and then click OK.

5. Click Find Next to search for the first occurrence of the format or style, and then click Replace to replace that one occurrence or Replace All to replace every occurrence.

Creating and modifying lists

Lists are paragraphs that start with a character and are formatted with a hanging indent so that the characters stand out on the left end of each list item. Fortunately, Word takes care of the formatting of lists for you. You simply indicate the type of list you want to create.

When the order of items is not important—for example, for a list of people or supplies—a bulleted list is the best choice. And when the order is important—for example, for the steps in a procedure—you will probably want to create a numbered list.

You can format an existing set of paragraphs as a list or create the list as you enter information into the document.
To format a new list item as you enter content, start the paragraph as follows:

- **Bulleted list** Enter *(an asterisk)* at the beginning of a paragraph, and then press the **Spacebar** or the **Tab** key before entering the list item text.

- **Numbered list** Enter **1.** (the number 1 followed by a period) at the beginning of a paragraph, and then press the **Spacebar** or the **Tab** key before entering the list item text.

When you start a list in this fashion, Word automatically formats it as a bulleted or numbered list. When you press Enter to start a new item, Word continues the formatting to the new paragraph. Typing items and pressing Enter adds subsequent bulleted or numbered items. To end the list, press Enter twice; or click the Bullets arrow or Numbering arrow in the Paragraph group on the Home tab, and then in the library, click None.

**TIP** If you want to start a paragraph with an asterisk or number but don’t want to format the paragraph as a bulleted or numbered list, click the AutoCorrect Options button that appears after Word changes the formatting, and then in the list, click the appropriate Undo option. You can also click the Undo button on the Quick Access Toolbar.

If you want to create a list that has multiple levels, start off by creating the list in the usual way. Then when you want the next list item to be a level lower (indented more), press the **Tab** key at the beginning of that paragraph, before you enter the lower-level list item text. If you want the next list item to be a level higher (indented less), press **Shift**+**Tab** at the beginning of the paragraph. In the case of a bulleted list, Word changes the bullet character for each item level. In the case of a numbered list, Word changes the type of numbering used, based on a predefined numbering scheme.

If you create a set of paragraphs containing a series of items and then decide you want to turn the set into a list, you can select the paragraphs and then click the Bullets, Numbering, or Multilevel List button in the Paragraph group on the Home tab.

After you create a list, you can modify, format, and customize the list as follows:

- You can move items around in a list, insert new items, or delete unwanted items. If the list is numbered, Word automatically updates the numbers.

- You can modify the indentation of the list by dragging the indent markers on the horizontal ruler. You can change both the overall indentation of the list and the relationship of the first line to the other lines.

  **SEE ALSO** For information about paragraph indentation, see “Manually changing the look of paragraphs” earlier in this chapter.
For a bulleted list, you can sort list items into ascending or descending order by clicking the **Sort** button in the **Paragraph** group on the **Home** tab.

For a bulleted list, you can change the bullet symbol by clicking the **Bullets** arrow in the **Paragraph** group and making a selection from the **Bullets** gallery. You can also define a custom bullet (even a picture bullet) by clicking **Define New Bullet**.

For a numbered list, you can change the number style by clicking the **Numbering** arrow in the **Paragraph** group and making a selection from the **Numbering** gallery. You can also define a custom style by clicking **Define New Number Format**.

For a numbered list, you can start a list or part of a list at a predefined number by clicking **Set Numbering Value** in the **Numbering** gallery and then entering the number you want in the **Set Numbering Value** dialog box.

You can start or restart a numbered list at any number.

For a multilevel list, you can change the numbering pattern or bullets by clicking the **Multilevel List** button in the **Paragraph** group and then clicking the pattern you want, or you can define a custom pattern by clicking **Define New Multilevel List**.

In this exercise, you’ll create a bulleted list and a numbered list and then modify the lists in various ways.

**SET UP** You need the Association document located in the Chapter03 practice file folder to complete this exercise. Open the document, display formatting marks and rulers, and then follow the steps.

1. Select the first four paragraphs below The rules fall into four categories, and then on the **Home** tab, in the **Paragraph** group, click the **Bullets** button to format the selected paragraphs as a bulleted list.
2. With the paragraphs still selected, in the **Paragraph** group, click the **Bullets** arrow to display the **Bullets** menu.
The Bullets menu offers several predefined bullet choices.

3 In the Bullets gallery, point to each bullet character under Bullet Library to display a live preview in the document, and then click the bullet composed of four diamonds to change the bullet character that begins each item in the selected list.

4 Select the two paragraphs below the Definitions heading, and then in the Paragraph group, click the Numbering button to number the selected paragraphs sequentially.

You can choose the bullet characters and numbering style that suit your document.
5 Select the first four paragraphs below the General Rules heading, and then click the Numbering button to format the paragraphs as a second numbered list. Notice that the new list starts with the number 1.

6 Select the next three paragraphs, and then in the Paragraph group, click the Bullets button to format the paragraphs as a bulleted list. Notice that Word uses the bullet symbol you specified earlier.

The new bulleted list is meant to be a subset of the preceding numbered list item and should be indented.

7 With the three bulleted items still selected, in the Paragraph group, click the Increase Indent button to move the bulleted paragraphs to the right. Notice that because you selected a custom bullet, the bullet character doesn’t change when the list items are indented.

**TIP** You can also adjust the indent level of a selected bulleted list by dragging the Left Indent marker on the ruler to the left or right. You can adjust the space between the bullets and their text by dragging only the Hanging Indent marker.

8 Select the remaining three paragraphs, and then click the Numbering button.

Word restarts the numbered list from 1 and an AutoCorrect Options button appears temporarily to the left of the list items.
You want the numbered list to continue the sequence of the previous numbered list.

9 Click the AutoCorrect Options button, and then click Continue Numbering.

**TROUBLESHOOTING** If the AutoCorrect Options button disappears, right-click the number preceding the No Large Dogs list item, and then click Continue Numbering.

10 In the No large dogs numbered item, click to the left of Seeing, press Enter, and then press Tab. Notice that Word first creates a new number 6 item and renumbers all subsequent items. However, when you press Tab to make this a second-level item, Word changes the 6 to an a, indents the item, and restores the original numbers to the subsequent items.

11 Press the End key, and then press Enter to start a new list item. Enter The Board reserves the right to make exceptions to this rule.

12 Press Enter, and then press Shift+Tab. In the new first-level item, enter All pets must reside within their Owners’ Apartments. Notice that the General Rules list is now organized hierarchically.

<table>
<thead>
<tr>
<th>General Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Each Apartment shall be used for residential purposes only, except such professional and administrative businesses as may be permitted by ordinance, provided there is no external evidence thereof.</td>
</tr>
<tr>
<td>2. No noxious or offensive activity shall be carried on, in, or upon any Apartment, Limited-Common Area, or Common Area; nor shall anything be done therein which may be an annoyance or nuisance to other residents.</td>
</tr>
<tr>
<td>3. No sports, activities, or games, whether organized or unorganized, that might cause damage to buildings, grounds, facilities, structures, or vehicles, or that are an annoyance or nuisance, shall be played in any limited-common area or common area.</td>
</tr>
<tr>
<td>4. No pets shall be kept in any apartment for any purpose other than as a pet. The number of cats and/or dogs any owner may keep is limited to the following:</td>
</tr>
<tr>
<td>▶ Two small dogs</td>
</tr>
<tr>
<td>▶ Two cats</td>
</tr>
<tr>
<td>▶ One cat and one small dog</td>
</tr>
<tr>
<td>5. No pets are allowed, either as pets of Owners or as pets of visitors.</td>
</tr>
<tr>
<td>a. No seeing-eye dogs may be permitted with written approval of the Board.</td>
</tr>
<tr>
<td>b. The Board reserves the right to make exceptions to this rule.</td>
</tr>
<tr>
<td>6. All pets must reside within their Owners’ Apartments.</td>
</tr>
<tr>
<td>7. Owners may keep other types of small pets that are confined to aquaria or cages.</td>
</tr>
<tr>
<td>8. Pets must be on a leash when in the Common Area.</td>
</tr>
</tbody>
</table>

*Word takes the work out of creating hierarchical lists.*

13 Select the three bulleted paragraphs, and then in the Paragraph group, click the Sort button to open the Sort Text dialog box.
Formatting text as you type

The Word list capabilities are only one example of the program’s ability to intuit how you want to format an element based on what you type. You can learn more about these and other AutoFormatting options by exploring the AutoCorrect dialog box, which you can open from the Proofing page of the Word Options dialog box.

The AutoFormat As You Type page shows the options Word implements by default, including bulleted and numbered lists.

You can select and clear options to control automatic formatting behavior.

One interesting option in this dialog box is Border Lines. When this check box is selected, typing three consecutive hyphens (-) or three consecutive underscores (_) and pressing Enter draws a single line across the page. Typing three consecutive equal signs (=) draws a double line, and typing three consecutive tildes (~) draws a zigzag line.
You can sort list items in ascending or descending order.

With the **Ascending** option selected, click **OK** to reorder the bulleted list items in ascending alphabetical order.

**CLEAN UP**  Close the Association document, saving your changes if you want to.

**Key points**

- Styles and style sets make it simple to apply combinations of character and paragraph formatting to give your documents structure and a professional look.

- The same document can look very different depending on the theme applied to it. Colors, fonts, and effects can be combined to create just the look you want.

- You can format characters with an almost limitless number of combinations of font, size, font style, and effect. For best results, resist the temptation to use more than a handful of combinations.

- You can change the look of paragraphs by varying their indentation, spacing, and alignment and by setting tab stops and applying borders and shading. Use these formatting options judiciously to create a balanced, uncluttered look.

- Bulleted and numbered lists are a great way to present information in an easy-to-read, easy-to-understand format. If the built-in bulleted and numbered formats don’t provide what you need, you can define your own formats.
Index

Numbers
3-D charts, 248

downloading and installing, 492
managing, 493
unloading, 493

diagrams, 230, 237
objects, in documents, 310
paragraphs, 120, 125
pictures, 175
table cells in Word, 156
text, in columns, 141
text, by using tab stops, 121, 126

tables of authorities, tables of. See tables of authorities
AutoCorrect, 86. See also spelling and grammar, checking
defined, 503
mathematical symbols, inserting by using, 294
options, changing, 87, 480
AutoFormat As You Type, 136
autoformatting options, selecting, 136
automatic save settings, adjusting, 55
AutoRecover, controlling settings for, 55, 482
autosaving documents, 55, 442
AutoShapes, defined, 503
AutoText user name/initials, changing, 278
axes, chart, 251

A

Accented Picture diagram, 239
accepting or rejecting changes, 436, 438
in merged documents, 441
accessibility
designing documents for, 329
of tables, 316
Accessibility Checker, 206, 331
accessible content, defined, 503
Account page of the Backstage view, 29, 30
adding
bibliographies, 394
building blocks, 473
commands to Quick Access Toolbar, 12, 487-492
comments, to documents, 430
cover pages, 276, 279
document headers and footers, 283
drop caps, 190
indexes, 388
page numbers, 276
picture diagrams, 239
process diagrams, 226
quote boxes, 285
symbols, 191
tables of authorities, 385
tables of contents, 379
tables of figures, 386
text boxes, 276, 286, 287
watermarks, 272
WordArt, 185, 186
add-ins, 492
defined, 503

addresses, saving in Word, 418
Align menu, 310
aligning
diagrams, 230, 237
objects, in documents, 310
paragraphs, 120, 125
pictures, 175
table cells in Word, 156
text, in columns, 141
alt text for tables, entering, 160
Apply Styles dialog box, 462
arranging windows, 45
artistic effects, applying to pictures, 176
aspect ratio, defined, 503
attaching templates, 457, 459, 466
attributes, defined, 503
author of document, viewing, 207
authorities, tables of. See tables of authorities
AutoCorrect, 86. See also spelling and grammar, checking
defined, 503
mathematical symbols, inserting by using, 294
options, changing, 87, 480
AutoFormat As You Type, 136
autoformatting options, selecting, 136
automatic save settings, adjusting, 55
AutoRecover, controlling settings for, 55, 482
autosaving documents, 55, 442
AutoShapes, defined, 503
AutoText user name/initials, changing, 278
axes, chart, 251

axes, charts 533
backgrounds, 265. See also watermarks
  changing, 266
colors, applying, 266
pictures as, applying, 269
Backstage view, 7, 25, 332
  Account page, 30
displaying, 11
Info page, 26, 207
New page, 27
Open page, 28
Print page, 194
Save As page, 29
balloons, defined, 503
bar charts, 250, 503
bar tabs, setting, 121
Basic Bending Process diagram, 233
bibliographies
  creating, 394
  inserting, 394, 400
  inserting citations, 397
  selecting style guide for, 395, 401
  sources, adding, 396
  updating, 395, 401
Bing Image Search, 177
blank documents, creating, 55
blog posts, publishing, 342
blogs, defined, 503
blue wavy underlines, 86. See also spelling and grammar, checking
bolding text, 111
book exercises, adapting for other display settings, 18
Bookmark dialog box, 361
bookmarks, 347
  defined, 503
displaying, 362
inserting, 360, 361
jumping to, 363
moving to, 360
naming, 362
borders
  page, 270
  paragraph, 124, 127
table, 165, 318
Borders And Shading dialog box, 124, 270
breaking links to embedded content, 354
breaks
column, 146
line, 119, 125
section, 141
brightness, adjusting for pictures, 174
bringing objects forward, 304, 313
browsers
  configuring webpages for, 334
  opening webpages in, 340
building blocks, 66, 265
  defined, 503
categories for, creating, 474
creating, 472
deleting, 278, 477
displaying, 477
inserting, 475
naming, 474
placeholders, deleting, 282
placeholder text, replacing, 285
previewing, 278, 285
properties, changing, 278
saving, 473, 475
sorting list of, 278
types of, 276
viewing information on, 277
working with, 473
Building Blocks Organizer dialog box, 277
building equations, 288
bullet symbol, changing, 132
bulleted lists
  adding items to, 131
  creating, 130, 132
  customizing, 131
  indenting, 134
  nesting, 131
  removing formatting, 131
  sorting, 135
Bullets menu, 132
buttons
  adding to Quick Access Toolbar, 488–490
  adding to ribbon tabs, 498
  arrows on, 13
  inactive, 20
  ScreenTips for, 12
Caption dialog box, 386
captioning picture diagrams, 241

captions
defined, 503
  adding for tables of figures, 387
case, text, 117
category axis, defined, 510
cell addresses, 155, 503
cells, defined, 503
cells, table
deleter, 154
  inserting, 153
  merging, 154, 156
  shading, 166
  splitting, 155
cells, worksheet, 246
center tabs, setting, 149
centering paragraphs, 120, 125, 129
Change Icon dialog box, 358
changes, tracking, 434
  accepting/rejecting changes, 436, 438
  activating, 434, 436
  when coauthoring, 450
  when comparing documents, 438
  displaying certain types of revisions, 435, 437
  displaying revisions, 436
  hiding revisions, 435, 437
  in merged documents, 441
  navigating revisions, 435
  reviewer name, changing, 435
  revision marks in, 434
  viewing ScreenTips for, 437
character formatting. See also fonts, modifying
defined, 503
  applying, 108
  automatically as you type, 136
  with bold, 111
  with colors, 114, 116
  for columnar text, 141
  copying, 111
  with drop caps, 190
  finding and replacing, 130
  highlighting text, 116
  shadow effects, 114
  small caps, applying, 102
  styles for, 463
  with styles, 94
  text case and, 117, 118
  with underlining, 110
character spacing, 108
defined, 503
  setting, 114
character styles, defined, 503. See also styles
chart area, 251
defined, 503
chart elements, 251
  displaying, 256
  formatting, 255
  hiding, 256
  modifying, 252
  removing, 256
  selecting, 252, 254
charts. See also chart elements
3-D, inserting, 248
activating, 252
color, applying, 253, 255
  copying external data to, 259
creating, 246, 247
data sources, selecting, 261
entering data in, 247, 248
formatting, 255, 256
inserting, 246, 247
modifying, 252
pasting data into, 260
placeholder text, replacing, 258
removing elements from, 256
saving, as templates, 258
selecting, 250
styles, applying, 253
switching rows and columns in, 250
three-dimensional, 248
titles, 250, 251
types, 250
types, changing, 252
checking spelling. See spelling and grammar, checking
chevrons, 411
   defined, 503
Choose A SmartArt Graphic dialog box, 225
citations. See also bibliographies; tables of authorities
   inserting, 397
   marking, 385
citing sources, 394, 395
clearing worksheet data, 248
Click And Type
   defined, 503
   positioning cursor by using, 120
clip art
   downloading, 177
   inserting, in documents, 170
Clipboard, 61
   defined, 504
   viewing, 67
closing
   documents, 10, 33, 43, 57
   panes, 22
   Word, 33
coauthoring documents, 6, 7, 450
collaborating on documents
   adding/reviewing comments, 430
   coauthoring documents, 450
   comparing and merging documents, 438
   controlling changes, 446
   managing document versions, 442
   password-protecting documents, 442
   rights management, 451
   tracking changes, 434
collapsing headings, 99
collapsing the ribbon, 12
color options, setting for pictures, 173
colors
   chart, changing, 253, 255
   diagram, changing, 235
   page, changing, 24, 43
   for page backgrounds, 266
   table, changing, 166
   text. See text colors
   for watermarks, 273
column breaks
   defined, 504
   inserting, 141, 146
column charts, 250
   defined, 504
columns. See also columns, table; columns, worksheet
   defined, 504
   assistive device limitations, 140
   displaying documents in, 42
   formatting text in, 141
   hyphenating text in, 145
   separating by using vertical lines, 144
   setting up, 140, 142
   spacing, adjusting, 144
   width, setting, 144
columns, table
   deleting, 154
   first, formatting, 165
   inserting, 153
   resizing, 154
   selecting, 153
   width, setting, 159
columns, worksheet
   resizing, 249
   selecting, 247, 249
Columns dialog box, 144
Columns gallery, 140
Combine Documents dialog box, 439
combining documents. See comparing and merging documents
commands
   adding to Quick Access Toolbar, 488–490
   adding to ribbon tabs, 498
comments
   defined, 504
   adding to documents, 430
   deleting, 431, 433
   displaying, 430, 431
   displaying by reviewer name, 431
   editing, 430, 433
   hiding, 431, 434
   inserting, 432
   navigating, 431
   replying to, 431, 433
   working with, 430
comparing and merging documents, 438
Compatibility Checker, 206
Compatibility mode, 58, 457
confidential information, removing, 206
contextual tabs. See tool tabs
contrast, adjusting for pictures, 174
converting documents to .docx format, 58
Convert Text To Table dialog box, 159
copying
diagrams, 237
pictures, 174
text, 61, 64
text, vs. cutting, 62
text formatting, 111
worksheet data, to Word charts, 260
correcting pictures, 174
cover pages, 276
adding, 279
modifying, 282
properties, viewing, 281
Create New Building Block dialog box, 292, 474
Create New Style From Formatting dialog box, 471, 464
creating
3-D charts, 248
blank documents, 55
charts, 246, 247
documents, 19, 52
folders, when saving documents, 53, 56
cropping pictures, 172
Cross-Reference dialog box, 364
cross-references, 348
defined, 504
creating, 360
inserting, 364
updating, 365
cursor, 52
defined, 504
moving and placing, 32, 34
positioning, by using Click And Type, 120
custom building blocks, creating, 472
custom styles, creating, 454, 460, 464, 471
custom templates, creating, 458, 467
customizing Word, 30
cutting
text, 61, 65
text, vs. copying, 62
text, in webpages, 337
cycle diagrams, 224
defined, 504
data labels, removing, 256
data markers
defined, 504
styles, applying, 253
data points, 246
defined, 504
selecting, 255
data series, 246
defined, 504
formatting, 255
data sources, defined, 504
data sources, chart, 261
data sources, mail merge, 403
creating, 405
creating mailing labels from, 425
email addresses as, 421
filtering and sorting, 405, 409
populating, 408
preparing, 404
selecting, 406
selecting Outlook contacts list as, 411
date and time
in cover pages, adding, 280
inserting, as field, 366, 368
Date And Time dialog box, 368
deactivating global templates, 460
decimal tabs, setting, 121, 127
definitions, looking up, 75
deleting
building block placeholders, 282
building blocks, 278, 477
Clipboard items, 67
comments, 431, 433
diagram shapes, 231
document themes, 107
hyperlinks, 349
index entries, 389, 393
page breaks, 201
password protection, from documents, 446
section breaks, 201
deleting (continued)
styles, 465
tab stops, 121
tables of contents, 381
text, 59, 60, 63
webpage objects, 337
Word table elements, 154
worksheet data, 248
demoting, defined, 504
demoting headings, 300
Design tab, 23
desktop publishing, defined, 504
destination files, defined, 504
diagrams. See also SmartArt diagrams
defined, 504
activating, 232
aligning, 230, 237
colors, applying, 235
copying and pasting, 237
creating, 224
descriptions, viewing, 226
entering text in, 227
layouts, selecting, 232
modifying, 231
picture, 239
positioning, 229, 237
previewing, 231, 233
punctuation in, avoiding, 227
resetting, 231
resizing, 228, 233
shape effects, applying, 236
shapes, adding, 228
shapes, deleting, 231
shapes, resizing, 240
shapes, selecting, 236
styles, applying, 234
wrapping text around, 229
dialog box launcher, defined, 504
dictionaries
adding words to, 91
installing, 81
looking up definitions in, 75
managing, 76
Dictionary pane, 76
digital signatures, defined, 504
display settings, changing, 16
distributing documents electronically, 206
docking panes, 21
document color, changing, 24, 43
document fields
automatic updating, 367
codes, displaying, 366
date and time, inserting, 366, 368
document headings
collapsing, 99
displaying, 364
displaying by level, 301
moving between, 36
selecting multiple, 99
Document Inspector, 206, 208
defined, 504
document outlines
collapsing headings in, 299
demoting headings, 300
displaying, 43, 299
displaying headings by level in, 301
headings, working with, 299
moving sections in, 302
promoting headings, 301
reorganizing, 298
document properties
inserting as fields, 367
tagging, 208
viewing, 207
document themes, 23
changing, 102
color palettes, assigning, 105
deleting, 107
finding location of, 104
fonts, modifying, 106
saving, 103, 106
setting default, 104
sharing, 104
document views, 14, 37
switching, 13
documents. See also Word; formatting documents
accessibility, designing for, 329
arranging windows, 45
autosaving, 442
backgrounds, changing, 266
borders, applying, 270
closing, 10, 33, 43, 57
coauthoring, 450
collaborating on. See collaborating on documents
columns in, 42
comparing and merging, 438
controlling changes to, 446
converting to .docx format, 58
creating, 52
displaying at page width, 42
displaying single page, 266
electronically distributing, 206
embedding linked objects in, 353
enabling editing, in Protected view, 33
encrypting, 445
fields in, 348
file formats for, 322
footnotes and endnotes, inserting, 374
full screen, expanding to, 10
gridlines, displaying/hiding, 152
headers and footers, inserting, 205, 283, 368
hyperlinks, inserting, 348
indexes, creating, 388
inserting into other documents, 59
mail merging, 403
margins, setting, 195, 197, 204
marking as final, 209
navigating, 32, 34, 40, 89, 101, 360
opening, 19, 27, 31
opening, as read-only, 31
opening earlier versions of, 322
opening, from the Backstage view, 39
opening, from previous Word versions, 58
opening, in Protected view, 31
paper size, selecting, 195
password-protecting, 442
pictures, inserting, 170, 171
previewing, 194, 196
previewing as webpages, 335
printing, 196
properties, viewing, 281
protecting, 209
quote boxes, adding, 285
read-only, opening, 444
read-only, recommending, 444
restricting formatting and editing, 446
rights management, 451
saving, 28, 53, 54
saving as other file types, 57, 323
saving, as PDF files, 324, 325
saving, as plain text, 323
saving, as webpages, 333, 340
saving, as XPS files, 324, 325
saving, automatic settings for, 55
saving a version of, 55
saving copies of, 57
saving in new locations, 53, 56
saving to SkyDrive, 54
screen clippings, inserting, 178
selecting, 60
shapes, inserting, 182
sharing, 6
statistics, viewing, 84
symbols, inserting, 191
tables of authorities, inserting, 385
tables of contents, creating, 378
tables of figures, 386
templates, working with, 19, 457. See also
templates
text boxes, adding, 286, 287
themes. See document themes
tracking changes, 434
translating, 79
versions, working with, 442
video clips, inserting, 177
views. See document views
webpages, creating from, 333
white space, hiding, 40
WordArt, inserting, 185
working with multiple, 38, 45
zooming in and out of, 13, 17, 40
.docx files, 58, 322
Don’t Merge List button, 64
Don’t Merge List button
double-sided printing, 212
downloading
  add-ins, 492
  practice files for book, x
Draft view, 37
  defined, 504
  switching to, 43
drag-and-drop editing, defined, 504
dragging, defined, 504
dragging and dropping text, 61
drawing canvases
  defined, 504
drawing shapes on, 182
drawing objects, 505. See also graphics
drawing shapes, 180
  on drawing canvases, 182
  with equal height and width, 182
drawing Word tables, 150
drawing text boxes, 286
drop caps
  defined, 505
  adding, 190
drop shadows, 114
ebook edition of book, xii
Edit Data Source dialog box, 408
Edit Name dialog box, 396
editing
  comments, 430, 433
  document fields, 370
  hyperlinks, 349, 351
  indexes, 389
  mail merge documents, 417
  PDF files in Word, 324
  pictures in documents, 170
  templates, 472
text. See editing text
tools, 51
editing text, 58. See also tracking changes
copying, 64
cutting, 65
cutting vs. copying, 62
deleting, 59
  in footnotes and endnotes, 376
inserting, 59
moving and copying, 61
pasting, 64, 67
repeating edits, 62, 99
restricting, 446
selecting, 59
  by using keyboard shortcuts, 62
  by using smart cut and paste, 64
undoing, 62, 65
in webpages, 337
effects
  font, 108, 109
  graphic, applying to diagrams, 236
text, 114
e-mail accounts, setting up as Microsoft accounts, 54
e-mail hyperlinks, 351
  opening, 352
e-mail messages
  previewing mail merge, 422
  sending by using mail merge, 419, 420
embedded objects, 353
  defined, 505
  creating from documents, 356
  icons, changing, 358
  linking to, 357
  locking links to, 359
  selecting, 355
  updating links to, 357
Encrypt Document dialog box, 445
encrypting documents, 445
endnotes, defined, 505. See also footnotes and endnotes
entering text, 56
  in diagrams, 227
  in tabbed lists, 147
  in Word tables, 152, 157
Enter Text dialog box, 340
envelopes, printing, 418
Envelopes And Labels dialog box, 418
Equation button, 289
Equation gallery, 293
Equation Options dialog box, 289
equations
  building, 288
  formatting, 292
  inserting from gallery, 289, 291
  inserting manually, 289, 290
errata for book, xiii
Excel. See workbooks; worksheets
exiting Word, 33
Extensible Markup Language (XML), defined, 505
extensions. See file name extensions

feedback on book, xiii
Field dialog box, 365, 370
field names, defined, 505
Field Options dialog box, 366
fields, document, 348
  defined, 505
  automatic updating, 367
codes, displaying, 366
date and time, inserting, 366, 368
editing, 370
inserting, 365
inserting document properties as, 367
tables of contents as, 383
working with, 366
figures, tables of. See tables of figures
File Explorer, 31, 324
file formats
  defined, 505
  .docx, 58, 322
  .pdf, 324, 325, 328
  .rtf, 323
setting default for saving, 482
  .txt, 323
for webpages, 333
in Word, 58
  .xps, 325
file name extensions, 56
files, inserting in documents, 59
fill effects, applying to backgrounds, 266
Fill Effects dialog box, 266, 268
Filter And Sort dialog box, 409
filtering
  defined, 505
data source for mail merge, 405, 409
finalizing documents, 209
Find And Replace dialog box, 70, 360, 363
Find Options dialog box, 73
finding and replacing formatting, 130
finding and replacing text, 68
  navigating results, 72
  replacing options, 71, 74
  with specific search options, 69, 73
  undoing results, 75
fine-tuning text, 75
first-line indent, setting, 119, 125
folders, creating, 53, 56
font colors, 108
Font dialog box, 113
  applying character formatting from, 109
font effects, defined, 505
Font group, applying character formatting from, 109
font size, defined, 505
font style, defined, 505
fonts, defined, 505
fonts, modifying, 108, 112
  case settings, 118
  with colors, 114
  with shadow effects, 114
  with small caps, 102, 113, 281
  with text effects, 109
  in themes, 106
  as uppercase, 117
footers, defined, 505. See also headers and footers
Footnote And Endnote dialog box, 374
footnotes, defined, 505
footnotes and endnotes
  adding text to, 375
  converting between, 377
  editing text in, 376
  inserting, 374, 375
  modifying format of, 374
  selecting, 377
form email messages, creating, 420
Format Data Series pane, 255
Format Painter, copying formatting by using, 111
formatting
chart elements, 255
documents. See formatting documents
equations, 292
indexes, 389, 391, 392
mail merged documents, 417
mailing labels, 424
marks. See formatting marks
options for, previewing, 14
pictures, 175
shapes, 184
symbols, displaying, 63
tables, 161, 164
tables of contents, 379
text. See paragraph formatting:
formatting documents
webpages, 335, 341
WordArt, 186, 188
formatting documents
fonts, changing, 106
limiting, when collaborating, 446
with page backgrounds, 266
with page borders, 270
page color, 24, 43
in sections, 200
with styles, 96
with tables, 315
with themes, 102
formatting marks
controlling display of, 481
displaying and hiding, 38, 42, 129
Formatting Restrictions dialog box, 447
Formula dialog box, 158
formulas
defined, 505
adding to Word tables, 158
constructing in Word tables, 155
Fraction gallery, 291
fractions, inserting, 289, 291
full screen documents, 10
functions, adding to Word tables, 155
fuzzy searching, 70

galleries, defined, 505
General Options dialog box, 443
global templates
attaching, 457, 460
deactivating, 460
Go To page of Find And Replace dialog box, 35
grammar, checking. See spelling and grammar, checking
Grammar pane, 86
graphs. See charts
graphics
defined, 505
aligning, 310
alternate text, including, 330
arranging on page, 304
fixing position on page, 309
hiding all, 314
moving, 304, 312
positioning on page, 309
selecting, 308
wrapping text around, 306
grayed out buttons, 20
grayscale, defined, 505
green wavy underlines, 86. See also spelling and grammar, checking
Grid And Guides dialog box, 311
gridlines. See also rulers and gridlines
defined, 506
chart, removing, 256
grouping, defined, 506
grouping objects, 312
grouping shapes, 181, 183
groups, defined, 506

hanging indent, setting, 119, 125, 126
headers and footers, 276. See also building blocks
defined, 506
configuring differently for odd/even pages, 283
editing, 284
inserting in documents, 205, 283, 368
headings, document
  collapsing, 299
demoting, 300
displaying, 364
displaying by level, 301
moving, 302
promoting, 301
selecting all, 302
working with, 299
Help for Word, 46
hidden characters, displaying and hiding, 38
hiding
  buttons on ribbon, 12
  comments, 431, 434
  rulers and gridlines, 312
text, 38
  tracked changes, 435, 437
  white space in documents, 40
hierarchy diagrams, 224, 506
highlighting text, 116
Home tab, 12
HTML (Hypertext Markup Language), defined, 506
HTML tags, 333
hyperlinks, 347
deleting, 349
to email addresses, 351, 352
inserting, 338, 348, 349, 365
jumping to target, 348, 350
ScreenTips, adding, 338, 351
ScreenTips, displaying, 350
ScreenTip text, including, 331
target frames, setting, 350
Hypertext Markup Language (HTML), defined, 506
hyphenating text
  defined, 506
  in columns, 141, 145

icons
  defined, 506
  for embedded objects, changing, 358
indent markers
  defined, 506
  setting, 119
indenting paragraphs, 118, 125
  in bulleted and numbered lists, 131, 134
  in columns, 145
Index dialog box, 392
index entries
  defined, 506
deleting, 389, 393
displaying, 389
formatting, 391
inserting fields for, 388
marking, 390
indexes
  defined, 506
columns, setting, 393
creating, 388
cross-references in, 388
editing, 389
formatting, 389, 392
marking all instances of words, 390
selecting terms for, 389
styles for, 392
updating, 389, 393
Info page of the Backstage view, 25, 207, 281, 332
Information Rights Management, 451
initials, user, changing, 278, 479
Insert Address Block dialog box, 412
Insert Greeting Line dialog box, 413
Insert Hyperlink dialog box, 349, 351
Insert Merge Field dialog box, 414
Insert Pictures dialog box, 268
Insert Pictures window, 241
Insert tab, 22
Insert Table dialog box, 150
Insert Table gallery, 149
inserting. See also adding
cross-references in, 388
charts, 246, 247
objects, in documents, 354
text, 59
inspecting documents, 208
jumping to hyperlink target, 348, 350
justifying text, 120, 125
   defined, 506
   in columns, 141

K
Keep Text Only button, 64
keyboard, navigating documents by using, 32, 511–531
keyboard shortcuts, 511–531
   defined, 506
   adding symbols by using, 191
   custom, creating, 531
   editing text by using, 62
Office, listed, 525
Word, listed, 511

L
Label Options dialog box, 424
labels, chart, 251
   removing, 256
labels, mail merging. See mail merge
labels, mailing. See mailing labels
landscape orientation
   defined, 506
   selecting, 195, 198
languages
   default translation, changing, 80
   setting options for, 483
   translating text from/to, 78, 83
Layout dialog box, 230, 306, 309
Layout Options menu, 228, 305, 335
Layout view, switching to, 42
left indent, setting, 119, 125
legal references. See citations
legends, chart, 251
   defined, 506
   removing, 256
licenses for use, obtaining, 451
line breaks
   defined, 506, 510
   creating, 55
   inserting, 119, 125
line charts, 250
   defined, 506
   creating, 252
line graphs, defined, 506
line spacing, adjusting for pictures, 171
lines, selecting, 60
linked objects, defined, 506
linking objects in documents, 353
linking text boxes, 286
links. See hyperlinks
list diagrams, 224, 506
lists, bulleted and numbered
   adding items to, 131
   continuing sequence of, 135
   creating, 130, 132, 133
   customizing, 131
   indenting, 134
   nesting, 131
   removing formatting, 131
   sorting, 135
lists, tabbed
   converting into tables, 151
   creating, 147
   entering text for, 147
   formatting, 148
Live Preview, 14, 506
locking embedded objects, 359

M
macros
   controlling settings for, 485
   displaying, 13
magnification. See screen magnification; zooming
mail merge
   defined, 507
   creating mailing labels, 423
data source, 403, 404
excluding recipients from, 417
field names, capitalizing, 404
formatting, 417
greeting lines, inserting, 413
main document, 403
main document, preparing, 411
merge fields, inserting, 412, 414
merging to new document, 417
navigating preview in, 416
Outlook contacts as source for, 411
previewing documents for, 415
previewing email messages for, 422
sending email messages, 419
Mail Merge pane, 405
Mail Merge Recipients dialog box, 407
Mail Merge wizard, creating labels by using, 424
mailing addresses, saving in Word, 418
mailing labels
  creating and printing, 423
  formatting, 424
  merging to printer, 427
  previewing, 426
  printing, 427
  replicating, 426
  setting up, 424
Mailings tab, 25
main document (mail merge), 403
defined, 507
  editing, 417
  merge fields, inserting, 412
  preparing, 411
manual page breaks, defined, 507
margins
defined, 507
defining, 118
mirroring, 198
setting, 195, 197, 204
for webpages, setting, 338
Margins list, 197
Mark Index Entry dialog box, 390
marking citations, 385
marking documents as final, 209
marking index entries, 388, 390
markup. See tracking changes
master documents, 299
Master List for sources, 397
matching case when searching, 69, 74
mathematical symbols. See also equations
  inserting, 289
  inserting by using AutoCorrect, 294
matrix diagrams, 224, 507
maximizing windows, 10, 15
merge fields
defined, 507
  inserting, 412
Merge List button, 64
Merge To E-Mail dialog box, 422
Merge To New Document dialog box, 417
Merge To Printer dialog box, 427
merging cells in Word tables, 154, 156
merging documents, 438
Microsoft accounts, setting up, 54
Microsoft Excel. See workbooks; worksheets
Microsoft Office Clipboard. See Clipboard
Microsoft Office Compatibility Pack, 58
Microsoft Word. See Word
Mini Translator
  applying character formatting from, 108
  displaying, 111
Mini Translator, 78
  translating text by using, 83
minimizing windows, 10
mirroring margins, 198
Modify Style dialog box, 463, 469
moving
document sections, in Outline view, 302
  graphics, 304
  objects, in documents, 312
  paragraphs, 66
  pictures, 174
text, 61
text boxes, 286
Word tables, 154
moving around in documents. See navigating documents
naming bookmarks, 362
building blocks, 474
navigating comments, 430, 431
documents. See navigating documents
tables, in Word, 152
tracked changes, 435
worksheets, 248
navigating documents
by using the cursor, 32, 34
jumping to specific page, 360
by using the keyboard, 32, 40
moving to beginning, 89, 101
by scrolling, 31
Navigation pane, 35, 72
defined, 507
displaying, 53, 491
working with, 303
nested tables, defined, 507
nesting tables in Word, 315
New Address List dialog box, 420
new documents, saving, 56
new features of Word 2013, 6
New page of the Backstage view, 26, 467
Normal template, 94, 454, 461
numbered lists
adding items to, 131
continuing sequence of, 135
creating, 130, 133
customizing, 131
indenting, 134
nesting, 131
removing formatting, 131
Object dialog box, 354
objects defined, 507
aligning, 310
arranging on page, 304
bringing forward, 313
fixing position on page, 309
grouping, 312
hiding all, 314
inserting in documents, 354
moving, 304, 312
positioning, 335
selecting, 308
snapping to grid, 312
stacking, 304
wrapping text around, 306
Office 2013 background, choosing, 30
Office 365, 4
Office Clipboard, 61
defined, 504
viewing, 67
Office Home & Student 2013 RT, 5
Office theme, 104
changing, 479
offline help, 46
online pictures
finding and downloading, 177
inserting, in documents, 170
Open dialog box, 328
Open page of the Backstage view, 27, 28
opening. See also opening documents
PDF files, in Word, 324, 328
templates, 19
webpages, in browser, 340
Word, 9, 18, 52
worksheets, in Word, 246
opening documents, 19, 27, 31
as read-only, 31
everalier versions of, 322
from the Backstage view, 39
from previous Word versions, 58
in Protected view, 31
Options dialog box (Word), 325
organization of book, ix
orientation. See page orientation
orphans defined, 507
avoiding, 200
Outline view, 37, 298
defined, 507
displaying, 299
outlines, around content. See borders
outlines, document
  collapsing, 99
displaying, 43, 299
headings, collapsing, 299
headings, demoting, 300
headings, displaying by level, 301
headings, promoting, 301
headings, working with, 299
moving sections in, 302
reorganizing, 298
Outlook contacts list, as mail merge source, 411

P
page breaks
  controlling options for, 200, 202
deleting, 201
inserting, 200, 203
  in tables of contents, inserting, 381
widows and orphans, avoiding, 200
page layout with tables, 315
Page Layout tab, 24
page numbers
  adding, 276
  formatting, 284
  viewing in status bar, 13
page orientation, 194
defined, 507
changing, 195
selecting, 198
Page Setup dialog box, 24, 195, 199
page setup, margins, 118
panes
  closing, 22
docking, 21
paper size, selecting, 195
Paragraph dialog box, 123, 202
paragraph formatting, 118
defined, 507
  background color, 128
  borders, applying, 124, 127
  for columnar text, 141
  with drop caps, 190
finding and replacing, 130
with styles, 94, 463
paragraph marks. See also formatting marks
displaying, 38, 42, 63
hiding, 38, 42
paragraphs. See also text
defined, 507
aligning, 120
background fill, setting, 128
centering, 120, 125, 129
creating, 55
indenting, 118, 125, 145
justifying, 120, 125, 141
keeping with next, 203
moving, 66
selecting, 59, 60, 64
spacing, 122, 127
starting new, 52
styles, 298, 507
Password dialog box, 444
password-protecting documents, 442
  opening as read-only, 444
  removing passwords, 446
passwords, selecting, 444
Paste Options menu, 337
pasting
  from Clipboard, 67
diagrams, 237
text, 61, 64, 67, 83
worksheet data, into Word charts, 260
paths, defined, 507
patterns, applying to document backgrounds, 268
PDF files
defined, 507
  editing, in Word, 324
  opening, in Word, 324, 328
  saving documents as, 324, 325
  working with, 325
permissions, restricting, 451
personal information, removing from documents, 209
picture backgrounds, applying, 269
picture diagrams, 224
defined, 507
  adding, 239

picture diagrams 547
picture diagrams (continued)
captioning, 241
creating, 239
formatting text in, 242
resizing, 240
shapes, resizing, 240
picture watermarks, 274
pictures. See also graphics defined, 507
adjusting line spacing for, 171
aligning, 175
artistic effects, applying, 176
color options, setting, 173
copying, 174
correcting, 174
cropping, 172
editing, in documents, 170
formatting, 175
inserting, in documents, 170
moving, 174
online, finding and downloading, 177
online, inserting in documents, 170
resizing, 170, 172
styles, applying, 174
wrapping text around, 172
pie charts, 250, 507
pinning the ribbon, 12
placeholders
deleting, 282
selecting text in, 288
plain text, saving documents as, 323
playing embedded videos, 177
plot area (chart), 251, 507
pointing, defined, 508
points, in font size, 114, 507
populating data source for mail merge, 408
portrait orientation defined, 508
selecting, 195
Position gallery, 308
positioning
diagrams, 229, 237
objects on page, 304
shapes, 183
WordArt, 187
posts, blog, defined, 508
PowerPoint presentations. See presentations (PowerPoint)
practice files, downloading and saving, x
prefixes, searching by, 70
preparing main document for mail merge, 411
presentations (PowerPoint), inserting in
documents, 355
previewing
building blocks, 278, 285
diagrams, 231, 233
documents, 194, 196
documents, as webpages, 335
e-mail mail merge, 422
mail merged documents, 415
mailing labels, 426
styles, 21, 461
templates, 52
Print Layout view, 37, 508
Print page of the Backstage view, 194
Printed Watermark dialog box, 273
printing
documents, 196
envelopes, 418
mailing labels, 427
options for, 212
process diagrams, 224
defined, 508
adding, 226
program icon, 10
program options, changing, 478
program window (Word), 10
maximizing, 15
promoting headings, 301
defined, 508
proofreading, importance of, 91
properties, document, viewing, 281
Protected view
enabling editing in, 33
opening documents in, 31
protecting documents, 209
publishing blog posts, 342
publishing documents as PDF/XPS files, 325
pull quotes, defined, 508
pyramid diagrams, 224, 508
queries, defined, 508
Quick Access Toolbar, 10
defined, 508
adding commands to, 12
creating document-specific, 491
customizing, 487
moving, 488, 491
resetting to default appearance, 492
separators, inserting, 490
Quick Layouts gallery, formatting charts by using, 256
Quick Parts. See also building blocks
button, 277
inserting, 365, 369
gallery, 476
Quick Styles, defined, 508
Quick Tables
defined, 508
creating, 162
gallery, 162, 163
inserting, 162
quote boxes, adding, 285

radicals, inserting, 289
ranges
cell, 246
table, 155
Read Mode view, 6, 37
defined, 508
switching to, 42
read-only documents
defined, 508
creating, 209
opening, 31, 444
recommending when collaborating, 444
recent documents
controlling settings for, 484
opening, 27
records, defined, 508
red wavy underlines, 86. See also spelling and grammar, checking
reference marks, 374, 508
reference materials
bibliographies, creating, 394
footnotes and endnotes, inserting, 374
indexes, creating, 388
tables of authorities, inserting, 385
tables of contents, creating, 378
tables of figures, inserting, 386
References tab, 24
rejecting or accepting changes
in documents, 436, 438
in merged documents, 441
relationship diagrams, 224, 508
relatively positioning objects, 304
releasing selections, 61
Rename dialog box, 496
repeating edits, 62, 99
replacing text, 71, 74. See also finding and replacing text
replicating mailing labels, 426
replying to comments, 431, 433
research tools, 51
resetting diagrams, 231
resizing
diagrams, 228, 233
picture diagrams, 240
pictures, 170, 172
shapes, 181, 184
text boxes, 286
watermarks, 275
Word tables, 154
worksheet elements, 249
resolution. See screen resolution, changing
restoring down, 10
Restrict Editing pane, 446
restricting document formatting and editing, 446
reverting edits, 62, 65
Review tab, 25
reviewing comments, 430
revision marks. See tracking changes
revisions, defined, 508
Revisions pane, 433, 439
ribbon, 10
collapsing, 12
commands, adding, 498
ribbon
ribbon (continued)
  commands, displaying, 20
  customizing, 494, 495
  differences in Word 2013, 487
  dynamic nature of, 14
  groups, displaying commands in, 15
  grouping, 15
  pinning, 12
  resetting to default appearance, 499
  unpinning, 12, 55
  width of, 15
ribbon tabs
  Design tab, 23
  Home tab, 12
  Insert tab, 22
  Mailings tab, 25
  Page Layout tab, 24
  References tab, 24
  Review tab, 25
Rich Text Format, saving documents as, 323
right indent, setting, 119, 125
right tabs, setting, 149
rights management, 451
rotating shapes, 183
rows, table
  changing heading direction, 165
  creating, 157
  deleting, 154
  header, repeating, 160
  header and total, formatting, 164
  height, setting, 160
  inserting, 153
  resizing, 154
  selecting, 153, 156
rows, worksheet, selecting, 247
.rtf files, saving documents as, 323
ruler
  displaying and hiding, 119
  setting tab stops by using, 120
rulers and gridlines
  displaying and hiding, 38, 42, 312
  document and table gridlines, 152

S
  saturation, defined, 508
  Save As dialog box, 53
  Save As page of the Backstage view, 28, 29
saving. See also saving documents
  AutoRecover information, 482
  building blocks, 473, 475
  charts, as templates, 258
  custom themes, 106
  practice files for book, x
  styles, 464
  tables, in Quick Tables gallery, 163
  templates, 458, 466, 467
  themes, 103
saving documents, 28, 53, 54, 56
  as other file types, 57, 323
  as PDF files, 324, 325
  as plain text, 323
  as webpages, 333, 340
  as XPS files, 324, 325
  automatic settings for, 55
  copies of, 57
  file formats for, 57, 322
  in new locations, 53, 56
  setting default options for, 482
  to SkyDrive, 54
  versions of, 55
scaling. See resizing
screen clippings
  defined, 508
  capturing, 178
  inserting in documents, 178
screen magnification, changing, 16
screen resolution, changing, 16
ScreenTips
  defined, 508
  customizing display of, 479
  displaying, 12, 46, 478
scrolling, 31, 34
  viewing page numbers when, 201
search tools, 51
searching
  for templates, 52
  text. See finding and replacing text
section breaks
  defined, 508
deleanging, 201
inserting, 201, 204
inserting around columns, 141
sections, document
  expanding, 300
  formatting separately, 141
Select Data Source dialog box, 261
Select Table dialog box, 406
selecting
  defined, 509
  all content, 201
  chart elements, 252, 254
  charts, 250
diagram shapes, 236
document headings, 302
embedded objects, 355
footnotes and endnotes, 377
non-adjacent text, 60
objects, in documents, 308
placeholder text, 288
with selection area, 60
shapes, 181
table elements, 156	
tables, 153, 317
tables of contents, 384
text, 59, 63, 143
text, all, 60
worksheet elements, 247, 249
selection area
  defined, 509
  selecting text, 60
Selection pane, 314
sending email messages by using mail merge, 419
sending objects backward, 304
sentences, selecting, 59. See also text
separators, inserting on Quick Access Toolbar, 490
series axis, defined, 510
Set Hyperlink ScreenTip dialog box, 338, 351
Set Numbering Value dialog box, 132
Set Target Frame dialog box, 350
shading paragraphs, 128
shadow effects, 114

shapes. See also graphics
  adding text to, 181, 183
  adding to SmartArt diagrams, 228
  coloring, 184
  deleting from SmartArt diagrams, 231
drawing, 180
drawing with equal height and width, 182
  formatting, 184
  grouping, 181, 183
  inserting in documents, 182
  modifying, 181, 184
  positioning, 183
  resizing, 181, 184
  rotating, 183
  selecting, 181
  selecting in SmartArt diagrams, 236
  styles, applying, 184
  wrapping text around, 181
shared locations, editing documents in, 450
sharing
documents, 6
document themes, 104
Show/Hide ¶ button, 42
single file webpages, saving documents as, 333
size, font, 108, 112
sizing. See resizing
sizing handles, defined, 509
SkyDrive
  accessing, 54
  saving files to, 54
small caps fonts, applying, 102, 113, 281
smart guides, 6
SmartArt diagrams
  defined, 509
  creating, 224
descriptions, viewing, 226
  entering text in, 227
  layouts, selecting, 225, 232
  picture, 239
  punctuation, avoiding, 227
  resizing, 228, 233
  shapes, adding, 228
  shapes, deleting, 231
  shapes, selecting, 236
SmartArt diagrams (continued)
styles, applying, 234
wrapping text around, 229
snapping objects to grid, 312
soft page breaks
defined, 509
inserting, 200
sorting
bulleted lists, 132, 135
data sources for mail merge, 405, 409
Word tables, 155
Source Manager dialog box, 395
sources, citing, 394, 395
spaces, displaying and hiding, 42, 63. See also formatting marks
spacing
columns, 144
lines, for pictures, 171
paragraphs, 122, 127
spelling and grammar, checking, 86
adding words to dictionary, 91
AutoCorrect options, changing, 87, 480
automatically, 86
grammar errors, double-checking, 89
removing squiggly lines from words, 97
replacing misspellings when, 88
Spelling pane, 86
splitting cells in Word tables, 155
stacking objects, 304
stacks, defined, 509
Start Enforcing Protection dialog box, 449
starting screen, 6
starting Word, 9, 18, 52
statistics, document, 84
status bar, 13
defined, 509
customizing, 500
status bar indicator, defined, 509
style area pane
defined, 509
displaying, 298, 299
Style Pane Options dialog box, 461
styles
defined, 509
accessibility design with, 330
applying, 94, 461, 468
applying multiple instances of, 99
applying, to pictures, 170
changing style sets, 95
for charts, 253
creating, 454, 460, 464, 471
deleting, 465
for diagrams, 234
displaying, 468
displaying list of, 100
finding and replacing, 130
for fonts, applying, 108
identifying, 463
for indexes, 392
modifying, 463, 469
previewing, 21
for pictures, 174
restricting, when collaborating, 446, 448
saving, 464
for shapes, 184
for tables, 161, 164
for tables of contents, 379, 382
for underlines, 111
updating, 460, 463, 470
viewing, 298
viewing ScreenTips on, 97
Styles gallery, 20, 94, 472
Styles pane, 21, 461
adding styles to, 100
subentries, defined, 509
suffixes, file. See file name extensions
suffixes, searching by, 70
support for book, xiii
switches, defined, 509
symbols, inserting in documents, 191
synonyms, looking up, 77, 82

T

tab leaders
defined, 509
setting, in tables of contents, 382
tabbed lists
defined, 509
converting into tables, 151
creating, 147
entering text for, 147
formatting, 148
Table Of Contents dialog box, 381
table styles, defined, 509
Table Styles gallery, 161
tables of authorities
  defined, 509
  inserting, 385
tables of contents
  defined, 509
  creating, 378
  deleting, 381
  formatting, 379
  inserting, 379
  page breaks, inserting in, 381
  selecting, 384
  styles for, 379, 382
  tab leaders, setting, 382
  updating, 379, 383
  working with, as field, 383
tables of figures
  defined, 509
  inserting, 386
tables, Word
  accessibility considerations for, 316, 331
  aligning cells in, 156
  alt text, entering, 160
  assistive device limitations, 151
  borders, removing, 318
  clearing formatting from, 318
  column width, setting, 159
  converting to or from existing text, 151, 159
  creating, 149, 156
  creating via Excel worksheets, 151
  deleting elements of, 154
  drawing directly, 150
  entering data in, 152, 157
  first column, formatting, 165
  formatting, 161, 164
  formulas, constructing, 155
  gridlines, displaying/hiding, 152
  header and total row formatting, 164
  headings, changing direction of, 165
inserting, 316
inserting rows or columns, 153
layout, modifying, 160
merging cells in, 154, 156
modifying structure of, 152
moving and sizing, 152, 154, 160
navigating in, 152
nesting, 315
for page layout, 315
performing calculations in, 155
Quick Tables, 162
repeating header row, 160
resizing, 154
saving in Quick Tables gallery, 163
selecting, 153, 317
selecting elements of, 156
shading cells in, 166
sorting data in, 155
splitting cells in, 155
styles, applying, 161, 164, 318
tabs. See formatting marks; tab stops
tabs, ribbon, 11
  adding, 496
  moving, 498
tab stops
  defined, 509
  aligning text by using, 121, 126
  deleting, 121
  displaying and hiding, 38, 42
  moving, 121
  setting, 120, 126, 147, 149
  tab leaders, applying, 121
tags, HTML, 333
targets, defined, 509
templates, 52
  defined, 510
  attaching, 457, 459, 466
  creating, 454, 458, 467
  creating documents directly from, 52
  creating documents from, 454
  editing, 472
  elements of, 456
  online and offline availability of, 455
  opening, 19
  previewing, 52
templates (continued)
saving, 458, 466, 467
saving charts as, 258
Templates And Add-Ins dialog box, 459
text
aligning, by using tab stops, 121, 126
copying, 61, 64
cutting, 61, 65
cutting vs. copying, 62
deleting, 59, 60, 63
dragging and dropping, 61
dragging, 61
dragging vs. cutting, 62
dragging vs. pasting, 61
dragging vs. selecting, 61
dragging vs. setting, 61
dragging vs. tab stops, 62
dragging vs. trimming, 61
dragging vs. undoing, 62
dragging vs. unpinning, 61
editing, 58
entering, 56
finding and replacing, 68
finding location of, 104
hyphenating, 141, 145
inserting, 59
moving, 61
pasting, 61, 64, 83
selecting, 59, 60, 63, 143
translating, 78, 83
text boxes
defined, 510
accessibility considerations for, 286, 330
adding, 276, 287
drawing, 286
inserting in shapes, 183
linking, 286
moving, 286
resizing, 286
text colors, applying, 114, 116
text formatting. See character formatting
Text pane, 228
text wrapping. See wrapping text
text wrapping breaks. See line breaks
texture fills, applying, 267
Theme Colors gallery, 105
Theme Fonts gallery, 106
themes, document, 23
defined, 510
changing, 102
color palettes, assigning, 105
deleting, 107
finding location of, 104
fonts, modifying, 106
saving, 103, 106
setting default, 104
sharing, 104
Themes gallery, 102
Thesaurus, looking up words in, 77
Thesaurus pane, 77, 83
three-dimensional charts, 248
thumbnails, 14, 510
tick-marks, defined, 510
tiling background images, 269
time. See date and time
title bar, 10	titles, document, inserting as fields, 369
tool tabs, 12, 510
Touch Mode, 5
tracking changes, 434
accepting/rejecting changes, 436, 438
activating, 434, 436
when coauthoring, 450
when comparing documents, 438
displaying certain types of revisions, 435, 437
displaying revisions, 436
hiding revisions, 435, 437
in merged documents, 441
navigating revisions, 435
reviewer name, changing, 435
revision marks in, 434
viewing ScreenTips for, 437
translating text, 78, 83
Translation Language Options dialog box, 80
Trust Center dialog box, 485
.txt files, saving documents as, 323
typos, 51
underlining text, 110
undoing edits, 62, 65
unloading add-ins, 493
unpinning the ribbon, 12, 55
Update Table Of Contents dialog box, 383
upgrading,

U

bibliographies, 395, 401
indexes, 389, 393
styles, 460, 463, 470

tables of contents, 379, 383

upgrading
from Word 2003, 8
from Word 2007, 7
from Word 2010, 6

uppercase fonts, applying, 117

use licenses, obtaining, 451

user interface
Office, 4
Word, 9

user name, changing, 278, 435, 479

V
value axis, defined, 510
versioning, document, 442

video clips
inserting, in documents, 177
working with, 177

View Shortcuts toolbar, defined, 510
View tab, 25

views, document. See document views
visual impairments. See accessibility

W
Watermark menu, 272

watermarks, 265. See also backgrounds
defined, 510
adding, 272
colors, applying, 273
pictures as, applying, 274
resizing, 275

wavy underlines, 86. See also spelling and grammar,
checking

web apps, 5

web browsers. See browsers
Web Layout view, 37, 335
defined, 510
switching to, 43

web logs. See blog posts, publishing

Web Options dialog box, 334

webpages
defined, 510
browser configuration, setting, 334
citing as sources, 398
creating, in Word, 333
deleting objects from, 337
editing text in, 337
file formats for, 333
formatting, 335, 341
hyperlinks, inserting, 338
margins, setting, 338
opening in browser, 340
positioning objects on, 335
previewing documents as, 335
saving documents as, 333, 340
selecting content in, 338

white space, hiding in documents, 40

widows
defined, 510
avoiding, 200

wildcard characters
defined, 510
searching by using, 70

windows, arranging, 45
Windows Explorer, 324

Word. See also documents
customizing, 30
exiting, 33
file format compatibility, 58
getting help with, 46
new features in, 6
RT version, 5
standard desktop installation, 4
starting, 9, 18, 52
upgrading from Word 2003, 8
upgrading from Word 2007, 7
upgrading from Word 2010, 6
user interface, 9
Web App, 5, 54
word choice, tools for, 75
word count
tooling, 84
viewing in status bar, 13

Word Count dialog box, 84

Word documents. See documents
Word Help window, 47
Word Options dialog box, 30, 362, 478, 489, 494
word processing, 3
  defined, 510
WordArt
  defined, 510
  adding to documents, 185
  converting text into, 185
  formatting, 186, 188
  inserting, 185, 186
  positioning, 187
  wrapping text around, 187
Word Web App, 5, 54
word wrapping, defined, 510
words. See also text
  definitions, looking up, 75
  selecting, 59, 63
  synonyms, finding, 77
workbooks, selecting as mail merge source, 406
worksheets
  arranging in windows, 259
  copying data to Word charts, 259
  data points in, 246
  deleting data from, 248
  entering data in, 248
  inserting in Word tables, 151
  navigating in, 248
  opening, in Word, 246
  selecting, 247
wrapping text
  defined, 510
  aligning objects and, 309
  around diagrams, 229
  around objects, 304, 306, 309
  around pictures, 172
  around shapes, 181
  around WordArt, 187

X
XML (Extensible Markup Language)
  defined, 505
  file formats, 58
XPS files
  saving documents as, 324, 325
  working with, 325

Z
Zoom button, 196
Zoom dialog box, 41
zooming, in documents, 13, 17, 38, 40